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Legal information 
 

Use of application examples 
Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG (“Siemens”). They are non-
binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 
By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  
The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with industrial security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 
Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  
For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity.

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
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1 Introduction 

1.1 Overview  

Motivation 

In order to visualize processes of modern automation systems, numerous process 
variables are required. During the process the user is informed about events by 
means of messages. The past process variables and messages are stored in 
archives and are therefore available to you at any time. 

WinCC stores the data compressed and binary coded in the archives. The archived 
process variables and messages can be displayed via WinCC controls. 

However, the underlying format is not suitable for analyzing and processing the 
data. 

The task 

The requirement is to export the data in other formats, e.g. as a "*.csv" or "*.xls" 
file. The data can then be conveniently further processed in Office applications, 
ERP and MES systems. 
 

Figure 1-1 

External data format

Office Applications, 
ERP-, MES systems

*.csv

*.xls

Visualization

Archive

 

Required knowledge 

Basic knowledge of WinCC V7 is required. 

 

Note Basics are taught in the SITRAIN course "SIMATIC WinCC, System Course." 

• SIMATIC WinCC, Systemkurs (de) 

• SIMATIC WinCC, System Course (en) 

 

  

https://www.sitrain-learning.siemens.com/DE/de/product/chapter/QAJ857V/course/4102607/description.do?hash=70ed32afecd3c67038578705e4f37c1c
https://www.sitrain-learning.siemens.com/DE/en/product/chapter/QAJ857V/course/4102608/description.do?hash=edfd73c2d6d9671c5c03b013f7fde363
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1.2 Principle of operation 

The option SIMATIC WinCC/Connectivity Pack is used to export the WinCC 
archive data. It provides the WinCC OLE DB Provider. 

The WinCC OLE DB Provider enables transparent access to the WinCC archive 
data. 

 

Figure 1-2 

External data format

Archive
Alarm Logging

WinCC
Application

*.csv
*.xls

A rchive 
Runtime Data

Archive
Tag Logging

Archive
FastTag Logging

Archive
Project Data

Archive
SlowTag Logging

Office Applications, 
ERP-, MES systems

WinCC/Connectivity Pack
OLE DB Provider

 

This document describes possible solutions for  
exporting archived data using Visual Basic (VB) scripts and the SQL Manager. The 
WinCC OLE DB provider is used here. 

 

The following data is exported: 

• Logged process values 

• Archived messages 

 

Three variants are considered for the creation of the new data formats: 

• Export of archive data via a VB script in the WinCC project 

• Export of archive data via Visual Basic for Applications (VBA) with Excel 

• Export of archive data via MS SQL Server Management Studio 
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1.3 Description of the WinCC application  

In this application example, a reverse osmosis plant for the treatment of process 
water is simulated for data acquisition, as it is used, for example, in the 
pharmaceutical industry or in breweries. 

Note The reverse osmosis system is designed as a WinCC project and is included as 
a download in the application example. 

 

The system has the operating states: 

• Approach 

• Production 

• Retract 

• Off 

 

VB scripts completely simulate the operating states. WinCC archives store the 
process variables and messages. 

1.3.1 Overview and description of the reverse osmosis system  

Figure 1-3 

 

 

The application example has several buttons that control the system and export 
archive data. 

Visually represented: 

• Valves 

• Various pressure displays  

• A drain and motor  
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Depending on the operating state, the associated HMI variables of the motor and 
valves are set to "ON" (1) or "OFF" (0). In the active state, the color of the objects 
is changed. Table 1-1 briefly describes how the buttons work. 

 

Table 1-1 

Buttons Description 

 
Use this button to activate the previous image. 

 

With this button you activate the start screen of the application 
example. 

 
Use this button to switch between German and English. 

 

Use this button to end the WinCC runtime of the application 
example. 

APPROACH Sets the system to the operating state "Approach". 

RETRACT Sets the system to the operating state "Approach". 

STOP Sets the system to the operating state "Off". 

Alarm Control Opens the ActiveX control "Alarm Control". This shows the past 
messages on the status of the plant. 

Trend control Opens the ActiveX control "Trend Control". This shows the temporal 
course of the simulated, analog measuring points of the system. 

Export Variable 
 

Starts the VBS script for exporting measured values to a "*.csv" file. 

Export messages 
 

Starts the VBS script to export the messages to a "*.csv" file. 

 

Table 1-2 

Valves (V) / Pump (P) Description 

V700 Fresh water valve 

V701 Processed water valve 

V702 Tank outflow valve 

V703 Concentrate valve 

V704 Valve CO2 

V705 Chemical valve 

V706 Outflow valve 

P800 Motor/Pump for fresh water 
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The current states of the simulated process variables are displayed via analog 
measuring points (I/O fields). Process variables described (Table 1-3): 

• Flows in the pipelines 

• Conductivity of liquids 

• The pressure conditions at different measuring points within the tank 

 

Table 1-3 

Analog  
Process tags 

unit Description 

FI100 m3/h Fresh water inflow 

FI101 m3/h Outflow tank 

FI102 m3/h Discharge outside the tank 

FI300 l/h Inflow CO2 

FI500 l/h Inflow chemical 

QI901 µS/cm Conductivity concentrate 

QI900 µS/cm Conductivity processed water 

PI200 bar Pressure sensor1 tank 

PI201 bar Pressure sensor2 tank 

PI202 bar Pressure sensor3 tank 

PI203 bar Pressure sensor4 tank 

 

Core functionality process 

 

Table 1-4 

No. Operating mode Note 

1.  Off After starting the application example in WinCC runtime, the 
system is in the "Off" operating state. 
The valves and motors are in the basic position (state: „0“). 
Analog measuring points have either their start value or the 
value "0". 

The "STOP" button is used to simulate an emergency 
intervention in the running system. The system is switched off 
and switches to the operating state "Off". 

2.  Approach After the "start-up" process, the system automatically switches 
to the "production" process.  
The valves and the engine open and start step by step. All 

analog measuring points are described with simulated values. 

3.  Production All valves and motor are activated. The analog measuring 
points are also described with simulated, slightly fluctuating 
values. 

4.  Retract After "shutting down" the system, the operating state "Off" is 
restored. 

The valves and the motor close or stop gradually. Still active 
measuring points are described with simulated values. 
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1.3.2 Functionality of the reverse osmosis system 

After starting the runtime, the actions "Measurement.bac" and 
"SimReverseOsmosis.bac" are called event-triggered, in which various procedures 
and functions are executed. They control the process flow and the simulation of the 
analog measured variables. The scripts were created with VBS. The complete 
plant process is simulated in twelve steps. Five steps for the start-up process, 
seven steps for the shutdown process, where the 
0 step reflects the status "Off" and the 5th step "Production". 

Actions 

Table 1-5 

Action  Call Trigger Description 

Measurement.bac cyclic  
Timer = 1 s 

Controls the calculation of values of 
the individual analog measuring 
points by calling the scripts 
"MeasMode" and "Measurement". 
The required simulation parameters 
are transferred within the action. 

SimReverseOsmosis.bac cyclic  
Timer = 1 s 

Simulates the reverse osmosis 
process by calling the scripts 
"StepControl" and "ActuatorControl". 

Procedures 

Table 1-6 

Procedure  Call Description 

StepControl.bmo Action 

„SimReverseOsmosis“ 

Simulates the individual steps of 
the plant using various sequences 
(StartupSequence, 
ShutdownSequence, 
StopSequence). 

MeasMode.bmo Action „Measurement“ Simulates the status of the 
individual analog measuring points. 

Measurement.bmo Action „Measurement“ Simulates the sizes of the individual 
analog measuring points. 

ActuatorControl.bmo Action 
“SimReverseOsmosis“ 

Simulates the states of valves and 
motors depending on the state of 
the system. 

WriteArchiveToCSV.bmo Trigger Button 

„WriteArchiveToCSV“ 

Creates a "*.csv" file, accesses the 
archive via the WinCC OLE DB 
Provider and writes the archive 
entries for the variable 
"QI901_ConductivityPermeatIn" 
into it. Only variable names, 
measurement time, variable ID and 
value are saved. 

WriteMessagesToCSV. 
bmo 

Trigger Button 

„WriteMessagesToCSV“ 

Creates a "*.csv" file, accesses the 
archive via the WinCC OLE DB 
Provider and writes the archive 
entries where the message number 
is <4 to it. Only the measurement 
time, message number, message 
type, and message class are 
saved.  
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Button „Start up“ 

• The start time is determined and entered in the "Start" output field. 

• The "StartupSequence" sequence is started. 

• The "Status" operating status display changes to the "Start-up" operating 
mode. 

• The valves and motors open and start step by step. All analog measuring 
points are described with simulated values. The "Start-up" process contains the 
following five steps: 

 

Figure 1-4 

V703: open

V706: open

Status:

Approach

Status:

Production

1

1

V700: open

P800: active 

V704: open

V705: open

V702: open

Current step = 1

Current step = 2

Current step = 3

Current step = 4

Current step = 5

 

All analog measuring points are described with simulated values. The values are freely 
selectable and can be adjusted at any time in the script. 
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Variables 

Table 1-7 

Variables Start value Min Max Increment 
values 

FI100_FlowRawwater 0 60 150 9 

FI101_FlowConcentrate 0 10 7 120 

FI102_SupplyWater 

= FI100 – 
FI101 + 

(FI300/1000) + 
(FI500/1000) 

- - - 

FI300_FlowCO2 0 1 19 2 

FI500_FlowChemicals 0 1 11 1.5 

QI900_ConductivityPermeatIn 1511 1310 1556 33 

QI901_ConductivityConcentrate 1900 1 300 2000 56 

PI200_Tank 0 1.1 5.5 0.35 

PI201_Tank 0 1.1 5.4 0.32 

PI202_Tank 0 1.1 5.3 0.31 

PI203_Tank 0 1.1 5.2 0.30 

• The curve recording starts event-triggered with the start of the system. 

• The start-up process takes approx. 25 s until the system switches to the 
"Production" operating state. 
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Button "Shutdown" 

The "Status" operating status display changes to the "shutdown" operating mode. 

• The sequence "ShutdownSequence" is started. 

• The valves and motors close and stop step by step. Still active analog 
measuring points are still described with simulated values. The "shutdown" 
process contains the following seven steps (steps 6-12). 

 

Figure 1-5 

V702: closed

Status:

Retract

Status:

Off

1

1

V704: closed

V705: closed

P800: inactive

V701: open

V703: open

V701: closed

V703: closed

Current step = 6

Current step = 7

Current step = 8

Current step = 10

Current step = 11

V700: closed Current step = 9

V706: closed Current step = 12

 

• The shutdown process takes approx. 25 s until the system changes to the "Off" 
operating state. 

• The curve recording stops event-triggered with "Off" of the system. 

• The stop time is determined and entered in the "Off" output field. 
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Stop button 

• The "Status" operating status display changes to the "Off" operating mode. 

• The "StopSequence" sequence is started. 

• The valves and motors close or stop immediately, analog measuring points are 
reset to their start value. 

• The curve recording stops event-triggered with the "Stop" of the system. 

• The stop time is determined and entered in the "Off" output field. 

• The system switches to the operating state "Off". 

Button „Production“ 

All valves and the motor are active (state: "1"). The analog measuring points are also described 

with simulated and slightly fluctuating values. (see Table 1-7). 

Button „off“ 

The valves and motors are in the basic position (state: "0"). Analog measuring points have 

either their start value (see Table 1-7) or the value "0". 

 

1.4 Components used 

The following hardware and software components were used to create this 
application example:  

 

Table 1-8 

Components Quantit
y 

Article number Note 

Engineering station 1 
 

Development computer 
with Windows 7x64 SP1 

SIMATIC WinCC V7.4 SP1 1 6AV63.1-....7-4...  

SIMATIC 
WinCC/Connectivity Pack 
V7.4 SP1 

1 6AV6371-1DR07-4... 
 

MS SQL Server 2008 R2 1   

MS Excel 2007, 2010, 
2013 

1  
 

 

This application example consists of the following components: 

 

Table 1-9 

Components File name 

WinCC project 38132261_Application_Reverse_Osmosis_PROJ.zip 

Excel files 38132261_Application_Reverse_Osmosis.xls 

38132261_Application_Universal_Client.xls 

Documentation 38132261_ Application_Reverse_Osmosis_DOC_de.pdf 
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2 Archive data exporting with WinCC 

2.1 Principle of operation 

• Data access to the runtime archive is via VBS scripts in WinCC. 

• The archive data is exported to CSV files.  

 

Figure 2-1 

Archive

*.csv

WinCC/Connectivity Pack
OLE DB Provider 

Exported data

• Variable 

"QI900_ConductivityPermeatIn"
• All notifications in the last 

24 h with MSGNR. < 4
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2.2 Configuration and project planning 

This chapter describes which configurations you have to perform in your own 
project to export archive data to a csv file using the WinCC OLE DB provider. 

 

Note The scripts shown in the section 2 are for illustration purposes only and have 
already been created in the WinCC project. The WinCC project is therefore 
immediately executable after the computer name has been adapted. 

2.2.1 Configurations in the example project 

Adapting the computer name 

1. Unpack the file with the name 
„38132261_Application_Reverse_Osmosis_PROJ.zip“ in any WinCC project 
directory on your computer. 

2. Open the WinCC project with the name 
„WinCC73_SE_UPD8_Connectivity_Pack.MCP“ and adjust the computer 
name in the computer properties in the project. To do this, use the context 
menu under "Computer > Properties" to adopt the Windows computer name of 
your PC. 

3. Start WinCC. 

Note The set resolution is 1520 x 900 pixels. 

The project is bilingual (switchable German/English) and therefore has a 
language switch. 

Script debugger 

If you want to debug the VB scripts, you can use a script debugger.As of SIMATIC 
WinCC V6.2, it is no longer included in the scope of delivery of SIMATIC WinCC for 
licensing reasons. 

To enable the display and debugging of script errors, set the following settings on 
the Runtime tab of the Machine Properties: 

Figure 2-2 

  

 

Note You can install the MS Script Debugger via your WinCC installation disk. Further 
information on this can be found in the online help for WinCC in the chapter 
"Testing with the Debugger". 
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Start Debugger 

If you activate the "Start Debugger" function, the debugger is started when the first 
script is started in the runtime. This function is used for quick troubleshooting 
during the project planning phase. 

You configure the "Start Debugger" function separately for VBS scripts in Graphics 
Designer images and for VBS scripts in Global Script. Activate the respective 
option box "Start Debugger". 

Note Further information can be found in the documentation "WinCC V7.4 Scripting: 
VBS, ANSI-C, VBA", in the chapter "How to activate the debugger". 

https://support.industry.siemens.com/cs/ww/en/view/109736230/70687471243 

Display error dialog 

If the function "Show error dialog" is activated, an error dialog with information 
about the occurred error is displayed when an error occurs in a VB script. A 
debugger can be started via a button in the error dialog. Prerequisite is an installed 
debugger for Visual Basic. 

The function "Show error dialog" can be configured separately for VB scripts in 
Graphics Designer images and for VB scripts in Global Script. For this reason, 
there are separate check boxes. 

2.2.2 Project engineering of scripts for the export of archive data 

After completion of a production cycle of the reverse osmosis system, the 
measured values archived between the start and stop times are entered in a "*.csv" 
file. 

The stop, start-up and shut-down times of the osmosis plant are entered in the 
message archive as operating messages. They have the registration numbers 1, 2 
and 3. In this application example, the start-up, shutdown and stop messages of 
the past 24 hours are to be written to a "*.csv" file.  

The solution of this task is shown by means of a script. It was created with the 
Global Script Editor of WinCC. Event triggered (by keystroke or variable trigger) it 
can be called up. 

2.2.3 Script for exporting archived variables  

For better illustration, only the measuring point QI900 (conductivity of the 
generated process water) is considered in this example. Their archived values are 
written to a "*csv" file at the press of a key. 

Alternatively, it is also possible to query several measured values simultaneously in 
VBS code. 

https://support.industry.siemens.com/cs/ww/en/view/109736230/70687471243
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Creation of the VBS module 

 

Table 2-1 

No. Action 

1.  Start the "Global Script VBS editor" editor.  

 

2.  Select the Project Module tab and create a new folder named 
WriteArchiveToCSV. 

 

3.  Create a new project module in this folder. 
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No. Action 

4.  Change the sub-procedure to a function. Add the parameters "ArchiveName" and 
"MeasuringPoint" to them. Save the project module under the name 
"WriteArchiveValuesToCSV". 

 
Archive name (parameter Archive name) and measuring point name (parameter 
MeasuringPoint) are not transferred until the function is called. 

 

VBS-Code: Creating the "*.csv" file 

In the first step of the VBS code, the "*.csv" file is first created in the folder 
"C:\Temp\". The file name should consist of the plant name "Osmosis", the start 
time of the osmosis plant and the measuring point name of the measuring point to 
be archived.  

(E.G.: C:\Temp\Osmosis_15.02.2015 10:30:00 QI900.csv) 

 

Table 2-2 

No. Action 

1.  Start the code by declaring the following variables: 

'Declaration of local Tags 

Dim fso    'FileSystemObject 

Dim f      'File 

Dim ts     'TextStream 

Dim path    'Path 

Dim StartArchive          'Starttime of Archiving 

Dim StopArchive           'Stoptime of Archiving 

Dim TimeStamp   'Timestamp for bulding filename 

2.  Use the following code to read out the start and stop times of the reverse osmosis 
system. The internal WinCC variables for this are "DateTimeLastStart" and 
"DateTimeLastStop". When the system is started and stopped, the respective times 
(format:.  dd.mm.yyyyy hh:mm:ss) are stored in the system. 

'Read Start- and Stoptime of Osmosis 

Set StartArchive = HMIRuntime.Tags("DateTimeLastStart") 

Set StopArchive = HMIRuntime.Tags("DateTimeLast") 

If the start or stop time is missing, a message is to be output and the processing of 
the function is to be terminated. 

If StartArchive.Read = "" Or StopArchive.Read = "" Then 

 MsgBox "Start- or Stoptime of Archiving is missing" 

 Exit Function 

End If 
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No. Action 

3.  Specify the path and file name. The variable "path" contains the complete file name 
with path in the form:  

C:\Temp\Osmosis_+ start time +_measuring point name  

The start time is used in the application example to create the file name and must 
first be converted to a suitable format. 

'Generate String for the *.csv filename and replace ":" with 

'"_" 

TimeStamp = FormatDateTime(StartArchive.Read, vbGeneralDate) 

TimeStamp = Replace(TimeStamp,":", "_") 

'Path and name for the *.csv -File 

path = "C:\Temp\" & "Osmosis_" & TimeStamp & "_" & 

MeasuringPoint & ".csv" 

4.  You then use the following code to create the file system object (fso) and the file 
object (f) using the path and file name (path) previously created. Before this, the 
system checks whether the file already exists and, in this case, terminates the 
processing of the function after a message has been output. 

'Create FileSystemObject and *.csv file if it not exist: 

Set fso = CreateObject("Scripting.FileSystemObject") 

If Not fso.FileExists(path) Then 

 fso.CreateTextFile(path) 

 Else 

 MsgBox "File already exist:" & vbCrLf & path 

 Exit Function 

End If 

Finally, the "*.csv" file with the TextStream object (ts) is opened for writing. 

'Create File-Object and open this File 

Set f = fso.GetFile(path) 

'iomode = 2, Writing 

'format = -2, TristateUseDefault 

Set ts = f.OpenAsTextStream(2,-2) 

'*.csv file is now ready for Writing 

The script is set up. The file is not created until the script has been executed. 

Connection to the Database 

In the second step of the function, the connection to the database is established 
using the WinCC OLE DB Provider. The measured value archive data are entered 
in a RecordSet (a copy of several data records). The following fields are transferred 
per record: 

 

Table 2-3 

Field No. Field name Type Meaning 

0 ValueID Integer (4 Byte) ID of the process value 

1 TimeStamp DateTime Time stamp of the process value 

2 RealValue Real (8 Byte) Process value 

3 Quality Integer (4 Byte) Quality code of the process value 
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Establishment of connection 

To establish a connection to the database, a connection object is created and the 
connection string is transferred. The ConnectionString requires: 

• Provider names 

• The provider instance number  

• The User Data Source Name (DSN, GUID of the WinCC project)  

• As data source WinCC incl. the computer name 
 

General format of the "ConnectionString": 

ConnectionString = "Provider=<Provider name>.<Instance no.>;Catalog=<DSN of 
the database>R;Data Source=<Computer name>\WinCC"". 

Note Access is also possible without specifying the computer name (.\WinCC). 
However, the access speed decreases. 

For transparent access for "Catalog", enter the name of the WinCC project, e.g.: 
„Catalog = WinCC_Project_Name“. 

 

Requesting of data 

The data is queried via a command object to which a "CommandText" is then 
passed for processing. In the "CommandText" must be passed: 

• The action (R = read access) 

• The ValueID or the symbolic name of the archive variable.  

• The start and stop time ("Start time" and "End time") 

 
Format of the „CommandText“: 

CommandText = "Tag:<Action>,< ValueID or ArchiveName\Tagname>', 
'<Starttime>,'<Stoptime>". 

Note To query multiple archived values simultaneously, specify the ValueIDs or 
variable names in parentheses and separated by semicolons (e.g. 
„TAG:R,('ValueName_1';'ValueName_2';'ValueName_x'), <TimeBegin>, 
<TimeEnd>“). 

 

The start and stop times can be absolute or relative. 

 

Table 2-4 

Start time Stop Time Requested time range 

2016-02-15 14:10:00:000 2016-02-15 14:30:00:000 15.02.2016 14:10 to 14:30 

2016-02-15 14:10:00:000 0000-00-00 01:00:00:000 15.02.2016 14:10 to 15:10 

0000-00-00 01:00:00:000 2016-02-15 14:30:00:000 15.02.2016 13:30 to 14:30 

0000-00-00 00:00:00:000 0000-00-00 00:01:00:000 Archive start to archive end plus 1 
min. 

0000-00-00 00:01:00:000 0000-00-00 00:00:00:000 Archive end minus 1 min until 
archive end  
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Note The time stamp of the process values is stored in UTC (coordinated world time). 
Therefore, the regional time zone and, if applicable, summer and winter time 
must be taken into account when specifying the start and end times in absolute 
form. 
You can find information on converting the local computer time to UTC under 
https://support.industry.siemens.com/cs/ww/en/view/24201113 

 

Note The query with "ValueID" is more performant than the query via 
„ArchiveName\Tagname“. However, the ValueID is not identical to the sequence 
of the variables in the tag logging editor. The ValueID of a tag can be determined 
via the SQL Server Management Studio. Open the dbo.Archive table in the 
project's runtime database using SQL Server Management Studio. The ValueID 
is listed in the first column of the table. 

 

Establishing the connection and querying the data 

 

Table 2-5 

No. Action 

1.  Declare the other variables: 

Dim Pro    'Provider  

Dim DSN    'Data Source Name  

Dim DS    'Data Source  

Dim ConnString   'Connection String  

Dim MachineNameRT  'Name of the PC from WinCC-RT  

Dim DSNRT    'Data Source Name from WinCC-RT  

Dim Conn    'Connection to ADODB  

Dim RecSet    'RecordSet  

Dim Command    'Query  

Dim CommandText   'Command-Text  

Dim CommandTextStart  'Starttime for SQL-String  

Dim Duration    'Duration of Production-Cycle  

Dim DurationSec   'Duration of Production-Cycle  

Dim DurationMin   'Duration of Production-Cycle  

Dim DurationHour  'Duration of Production-Cycle  

Dim DurationDay   'Duration of Production-Cycle  

Dim Language   'Language tag  

https://support.industry.siemens.com/cs/ww/en/view/24201113
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No. Action 

2.  Use the following code to read the host name and GUID of the project from the 
@LocalMachineName and @DataSourceNameRT environment variables into the 
previously declared local variables. 

'Read the name of the PC-Station and the DSN-Name from 

'WinCC-RT  

Set MachineNameRT = HMIRuntime.Tags("@LocalMachineName") 

Set DSNRT = HMIRuntime.Tags("@DatasourceNameRT") 

You use these variables to form the "ConnectionString". 

'Preparing the Connection-String  

'First instance of WinCCOLEDB 

Pro="Provider=WinCCOLEDBProvider.1;"       

'Name of Runtime-Database 

DSN="Catalog=" & DSNRT.Read & ";"     

'Data Source  

DS= "Data Source=" & MachineNameRT.Read & "\WinCC"   

'Build the complete String:  

ConnString = Pro + DSN + DS  

3.  Connect to the database using the ConnectionString application: 

'Make Connection  

Set Conn = CreateObject("ADODB.Connection")  

Conn.ConnectionString = ConnString  

Conn.CursorLocation = 3 

Conn.open 

Note: 

To specify the location of the RecordSet for retrieving archive data, assign a value 
to the "CursorLocation" property. In the example, the value "3" is assigned. The 
RecordSet is thus created on the client. 

4.  To query the data in the WinCC database, the "Command Text" is required. 

In this example, the relative time is used for the query. The start time is the 
difference between the start time and the end time. The query thus covers the 
period "archive end minus time difference to archive end". (see Table 2-4). 

The full time difference is first calculated in seconds and then converted to the 
time format "Days:Hours:Minutes:Seconds". During formatting, the leading zeros 
are also generated for numerical values greater than 10. 

'Duration between Start an Stop in seconds:  

Duration = DateDiff ("s",StartArchive.Read,StopArchive.Read) 

'Split the Duration in days, hours, minutes and seconds:  

DurationMin  = Fix(Duration/60)  

DurationSec  = Duration - (DurationMin * 60)  

DurationHour = Fix(DurationMin/60)  

DurationMin  = DurationMin -(DurationHour * 60)  

DurationDay  = Fix(DurationHour/ 24)  

DurationHour = DurationHour - (DurationDay * 24)  

'Creating leading zeros:  

DurationSec  = Right("00" & DurationSec,2)  

DurationMin  = Right("00" & DurationMin,2)  

DurationHour = Right("00" & DurationHour,2)  

DurationDay  = Right("00" & DurationDay,2) 
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No. Action 

5.  Form the "CommandText" from the archive name, the archive variable that you 
want to read, the start time and the calculated time difference. 

'Formating Starttime:  

CommandTextStart = "'0000-00-" & DurationDay & " " & 

DurationHour & ":" & DurationMin & ":" & DurationSec & 

".000'"  

'Building the complete String:  

CommandText="Tag:R,'" & Archivename & "\" & MeasuringPoint & 

"'," & CommandTextStart & ",'0000-00-00 00:00:00.000'"  

6.  Create the command object and define the "CommandType". 

Then the query with the previously created CommandText follows. The RecordSet 
is then set to the first data record in which the first, and therefore oldest, process 
value is stored. 

'Create the recordset, read the records and set to first 

‘redcordset:  

Set Command = CreateObject("ADODB.Command")  

Command.CommandType = 1  

Set Command.ActiveConnection = Conn  

Command.CommandText=CommandText  

Set RecSet = Command.Execute  

RecSet.MoveFirst 

 

Note When using the time and date format in WinCC and Visual Basic, note that the 
date format depends on the region set in Windows. The DDPS code is designed 
in such a way that date and time are evaluated independently of these computer-
specific settings. 
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Writing the "*.csv" file 

The records from the previously opened RecordSet are written to the "*.csv" file. 

 

Table 2-6 

No. Action 

1.  The following loop writes the data records (measuring point name, variable ID, time 
stamp (UTC), process value) line by line into the "*.csv" file. A row with the column 
headings is created first. The current runtime language setting is taken into account 
(HMIRuntime.Language; 1031 = German, 1033 = English). 

The RecordSet is placed on the next record with each run. 

'write recordsets To *.csv-File  

'Header in *.csv-File  

Language = HMIRuntime.Language 

Select Case Language 

Case 1031  'German = 1031  

ts.WriteLine ("Tag-Name;ValueID;Datum/Zeit;Prozesswert") 

'MsgBox "Tag-Name;ValueID;Datum/Zeit;Prozesswert"  

Case 1033  'English = 1033 

ts.WriteLine ("Tag-Name;ValueID;Date/Time;Process-Value") 

'MsgBox "Tag-Name;ValueID;Date/Time;Process-Value"    

End Select 

 

Do While Not RecSet.EOF  

ts.WriteLine (MeasuringPoint & ";" & 

RecSet.Fields("ValueID").Value & ";" & 

RecSet.Fields("TimeStamp").Value & ";" & 

RecSet.Fields("RealValue").Value)  

RecSet.MoveNext  

Loop  

 

Select Case Language 

Case 1031  'German = 1031  

MsgBox "Schreiben der Datei"  & vbCrLf & 

“C:\Users\os\Documents\" & "Osmosis_" & TimeStamp & "_" & 

MeasuringPoint & ".csv" & vbCrLf & "erfolgreich!" 

Case 1033  'English = 1033 

MsgBox "Writing of File"  & vbCrLf & "C:\Users\os\Documents\" 

& "Osmosis_" & TimeStamp & "_" & MeasuringPoint & ".csv" & 

vbCrLf & "successful!"   

End Select  
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No. Action 

2.  At the end of the script, the connection to the database is terminated and the 
objects are released. 

' Close all 

ts.Close  

RecSet.Close  

Set ReCset = Nothing  

Set Command = Nothing  

conn.Close    'Close connection  

Set Conn = Nothing  

Set fso = Nothing  

Set f = Nothing  

Set ts = Nothing  

End Function 

3.  Save the script. The script is now available for call. 
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Calling the Function in the Process Screen 

The function "WriteArchiveValuesToCSV" needs the two parameters 
"Archivename" and "MeasuringPoint" for the call. 

The parameter "Archive name" corresponds to the name of the archive in which the 
variable to be read is located. In this application example, the archive is "Process 
value archive". 

The "MeasuringPoint" corresponds to the name of the archive variable to be read 
(tag), for example the variable "QI900_ConductivityPermeatIn" is to be used. 

In the image "ReverseOsmosis.Pdl" the script is called via the corresponding 
button. 

 

Table 2-7 

No. Action 

1.  Open the image "ReverseOsmosis.Pdl" in the Graphics Designer. 

2.  Open the properties dialog of the "Export Variable" button and open the DDPS 
editor under "Events > Mouse > Mouse Click > DDPS Action". 

 

3.  Call the previously created script with the following code. 

Sub OnClick(Byval Item)  

Dim ArchiveName 

Dim MeasuringPoint 

ArchiveName = "Prozesswertarchiv" 

MeasuringPoint = "QI900_ConductivityPermeatIn" 

Call WriteArchiveValueToCSV (ArchiveName, MeasuringPoint) 

End Sub 

4.  Save the image. 
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2.2.4 Script for exporting archived messages 

The start-up and shut-down times as well as the stop time of the osmosis plant are 
entered in the message archive as operating messages. You have the registration 
number 1-3. In this application example, the start-up, shutdown and stop messages 
that have occurred in the last 24 hours are to be written to a  
"*.csv" file.  

The procedure corresponds here essentially to the writing of measured value 
archives (section 2.2.3) in a „*.csv file“. Differences exist only in the structure of the 
RecordSet and in the query of the data records. 

Creation of the VBS module 

 

Table 2-8 

No. Action 

1.  Start the Global VBS Editor in the WinCC application example. 
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No. Action 

2.  If section 2.2.3 has already been edited, step no. 2 can be omitted.  

Select the Project Module tab and create a new folder named WriteArchiveToCSV.  

 

3.  Create a new project module in this folder. 

 

4.  Change the name of the procedure and save the Project module as 
"WriteArchiveMessagesToCSV". 
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VBS-Code: Creating the "*.csv" file 

In the first step of the VBS code, the "*.csv" file is first created in the folder 
"C:\Temp\". The file name should consist of the plant name "Osmosis", the start 
time of the osmosis plant and the addition "Messages". 

For Example: C:\Temp\Osmosis_15.02.2015 10:30:00_Messages.csv 

 

Table 2-9 

No. Action 

1.  Declare the following variables: 

'Declaration of local Tags 

Dim fso   'FileSystemObject 

Dim f     'File 

Dim ts    'TextStream 

Dim path  'path  

Dim StartTime  'Date and Time when writing is triggerd 

Dim TimeStamp  'Timestamp for bulding filename 

2.  Specify the path and file name. The variable "path" contains the complete file name 
with path in the form: 

C:\users\<username>\Documents\Osmosis_ + start time + _Messages.csv 

Use the following code to read out the current system time and define it as the start 
time. The start time is used in the application example to create the file name and 
must first be converted to a suitable format.  

'Date and Time when writing is triggerd 

StartTime = Now 

'Generate String for the *.csv filename and replace ":" with 

"_" 

TimeStamp = FormatDateTime(StartTime, vbGeneralDate) 

TimeStamp = Replace(TimeStamp,":", "_") 

'Path and name for the *.csv file 

path ="C:\Temp\" & "Osmosis_" & TimeStamp & "_Messages.csv" 
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No. Action 

3.  Use the following code to create the file system object (fso) and the file object (f) 
using the previously created path and file name (path). The system first checks 
whether the file already exists. In this case, processing of the function ends after a 
message has been issued. 

'Create FileSystemObject and *.csv file if it not exist: 

Set fso = CreateObject("Scripting.FileSystemObject") 

If Not fso.FileExists(path) Then 

  fso.CreateTextFile(path) 

 Else 

  MsgBox "File already exist:" & vbCrLf & path 

 Exit Sub 

End If 

The "*csv" file with the TextStream object (ts) is then opened for writing. 

'Create File-Object and open this File 

Set f = fso.GetFile(path) 

Set ts = f.OpenAsTextStream(2,-2) 

'iomode = 2, Writing  

'format = -2, TristateUseDefault 

'*.csv-File is now ready for Writing 

Connection to the Database 

In the second step of the sub-procedure, the connection to the database is 
established using the WinCC OLE DB Provider. At least one of the following points 
is required for the compound. 

• The archive from which the data is to be read is part of a  
WinCC runtime project. 

• The archive from which the data is to be read is connected in the SQL 
Manager via "Attach Database". 

• The archive from which the data is to be read is connected via the "Archive 
Connector". 

 

An SQL command set is formed for the query of the message archive data. A 
message archive data record is structured accordingly Table 2-10. The field names 
can be addressed directly in the SQL query. 

 

Table 2-10 

Field No. Field name Type Meaning 

1 MsgNr Integer (4 Byte) Message number 

2 State Small Integer 2 Byte Status of the message 

3 DateTime DateTime 8 Byte Message timestamp (date time 
without milliseconds) 

4 Ms Small Integer 2 Byte Message time stamp 
(milliseconds) 

5 Instance VarChar(255) Instance name of the message 

6 Flags1 Integer 4 Byte (internal use only) 

7 PValueUsed Integer 4 Byte Process Values used 

8-17 PValue1 to Real 8 Byte Numerical process value 1 to 10 
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Field No. Field name Type Meaning 

PValue10 

18-28 PText1 to PText10 VarChar(255) Process value text 1 to 10 

28 Computer name VarChar(255) Computer name 

29 Application VarChar(255) Application name 

30 Comment VarChar(255) Comment 

31 User name VarChar(255) User name 

32 Counter Integer 4 Byte Continuous message counter 

33 TimeDiff Integer 4 Byte Time difference to "Coming" 
state 

34 Class name VarChar(255) Name of reporting class 

35 Type name VarChar(255) Name of message type 

36 Class Small Integer 2 Byte ID of the message class 

37 Type Small Integer 2 Byte ID of the message type 

38 to 47 Text1 to Text10 VarChar(255) Message Text 1 to 10 

48 AG_NR Small Integer 2 Byte Number of the AG 

49 CPU_NR Small Integer 2 Byte CPU number 

 

50 CrComeFore Integer 4 Byte Foreground color for "come" 
status 

51 CrComeBack Integer 4 Byte Background color for status 
"come" 

52 CrGoFore Integer 4 Byte foreground color for status 
"gone" 

53 CrGoBack Integer 4 Byte Background color for status 
"gone" 

54 CrAckFore Integer 4 Byte Foreground color for status 
"acknowledged" 

55 CrAckBack Integer 4 Byte Background Color for the 
"Acknowledged" status 

56 LocaIID Integer 4 Byte Location of the alarm 

57 Priority Integer 4 Byte Priority 

58 AP_type Integer 4 Byte Loop in Alarm 

59 AP_name VarChar(255) Loop-in-Alarm Function Name 

60 AP_PAR VarChar(255) Loop-in-Alarm Screen 

61 InfoText VarChar(255) Infotext 

62 TxtCame VarChar(255) Text came in 

63 TxtWent VarChar(255) Text went out 

64 TxtCameNWent VarChar(255) Text came in and went out 

65 TxtAck VarChar(255) Text acknowledged 

66 AlarmTag Integer 4 Byte Message tag 

67 AckType Small Integer 2 Byte Acknowledgment Type 

68 Params Integer 4 Byte Parameters 

69 Server name VarChar(255) Server name 
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Establishment of connection 

To establish the connection to the database, a connection object is created and the 
"ConnectionString" is passed. The "ConnectionString" requires the following 
parameters. 

• Provider names  

• The provider instance number 

• The user DSN (GUID of the WinCC project)  

• As data source WinCC incl. the computer name. 

 

General format of the "ConnectionString": 

ConnectionString = "Provider=<Provider name>.<Instance no.>;Catalog=<DSN of 
the database>R;Data Source=<Computer name>\WinCC"". 

Note Access is also possible without specifying the computer name (.\WinCC). 
However, the performance is lower. 

For transparent access for "Catalog", enter the name of the WinCC project, e.g.: 
"Catalog=WinCC_Project_Name". 

 

Requesting of data 

To query the data, a command object is created to which a "CommandText" is 
passed for processing. The "CommandText" contains the following parameters.  

• One command set (ALARMVIEWEX:Select)  

• The name of the database table (ViewName) 

• Conditions:  
 

General format of the "CommandText": 

CommantText = "<Command set> * FROM <Name of database table> WHERE 
<Condition>" 

 

Table 2-11 

Parameters Description 

ViewName Name of the database table. The table must be specified 

in the desired language. The "ViewName" for the five 

European language is e.g.: 

 

ALGVIEWEXDEU: German message archive data 

ALGVIEWEXENU: English message archive data 

ALGVIEWEXESP: Spanish message archive data 

ALGVIEWEXFRA: French message archive data 

ALGVIEWEXITA: Italian message archive data 

 

The "ViewName" for the Asian language is e.g.: 

ALGVIEWEXCHS: Chinese (simplified) message archive data 

ALGVIEWEXCHT: Chinese (traditional) message archive data 

ALGVIEWEXJPN: Japanese message archive data 

ALGVIEWEXKOR: Korean message archive data 

 

Condition Specifies the condition(s) for the message archive query. 
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Parameters Description 

Example of requests 

DateTime>'2003-06-01' AND DateTime<'2003-07-01' 

DateTime>'2003-06-01 17:30:00' 

MsgNr = 5 

MsgNr in (4, 5) 

State = 2 

 

Note 

Only absolute times can be used with DateTime. 

Example: 

The "CommandText" reads all German entries of message number 5 which were 
entered after 01.01.2016: 

“ALARMVIEWEX:Select * FROM ALGVIEWEXDEU WHERE MsgNr=5 and DateTime > 

‘2016-01-01’“ 

 

Note 
From WinCC V7.2 UNICODE is supported. Therefore the archive access of 
alarms has changed. With older versions of WinCC (less than V7.2) the alarm 
archive is accessed via ALARMVIEW (instead of ALARMVIEWEX). 
 
It is possible to query several conditions at the same time. Strings must be linked 
with an "&" character. Condition enumeration by "AND", e.g:  
CommandText = "<Command set>* FROM <Language setting>  WHERE" & 
"<Condition 1>" & "AND <Condition 2>" & "AND <Condition 2>" 
 
The languages that are installed in the WinCC base system or that are 
configured in the WinCC Text Library are supported. Information concerning the 
possible query-languages or the respective "ViewName" can be found in the 
SQL-Server in the linked alarm archives under "Views". All languages that are 
supported in the corresponding archive are shown here with their IDs, e.g. 
"ALGVIEWEXENU". 

 

Note The start time and stop time can be transferred absolute or relative (see Table 2-
4). 
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Establishing a connection and requesting data 

 

Table 2-12 

No. Action 

1.  Declare the other variables: 

'Declaration of Script Tags 

Dim Pro   'Provider  

Dim DSN   'Data Source Name  

Dim DS   'Data Source  

Dim ConnString  'Connection String  

Dim MachineNameRT 'Name of the PC from WinCC-RT  

Dim DSNRT   'Data Source Name from WinCC-RT  

Dim Conn   'Connection to ADODB  

Dim CommandText  'Command-Text  

Dim SqlSec   'Duration of Production-Cycle  

Dim SqlMin  'Duration of Production-Cycle  

Dim SqlHour  'Duration of Production-Cycle  

Dim SqlDay   'Duration of Production-Cycle  

Dim SqlMonth   'Duration of Production-Cycle  

Dim SqlYear   'Duration of Production-Cycle 

Dim RecSet   'RecordSet  

Dim Command  'Query  

Dim Language  'Language Tag 

2.  Use the following code to read the host name and GUID of the project from the 
@LocalMachineName and @DataSourceNameRT environment variables into the 
previously declared local variables. 

'Read the name of the PC-Station and the DSN-Name from  

'WinCC-RT  

Set MachineNameRT = HMIRuntime.Tags("@LocalMachineName") 

Set DSNRT = HMIRuntime.Tags("@DatasourceNameRT") 

You use these variables to form the "ConnectionString". 

'Preparing the Connection-String  

'First instance of WinCCOLEDB 

Pro = "Provider=WinCCOLEDBProvider.1;" 

'Name of Runtime-Database 

DSN = "Catalog=" & DSNRT.Read & ";" 

'Data Source  

DS = "Data Source=" & MachineNameRT.Read & "\WinCC"   

'Build the complete String:  

ConnString = Pro + DSN + DS 

3.  You then establish the connection to the database. 

'Connection based on ODB-Provider 

Set Conn = CreateObject("ADODB.Connection")  

Conn.ConnectionString = ConnString  

Conn.CursorLocation = 3 

Conn.open 
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No. Action 

4.  To query the data in the WinCC database, the "Command Text" is required. 

In this example, the previously saved start time of the query (pressing the button) is 
recorded. This point in time must be reformatted to the display format "YYYY-MM-
DD hh:mm:ss". 

During formatting, the leading zeros are also generated for numerical values smaller 
than 10. 

'FormatStarttime for SQL-Statement 

'Fomat needed for StartTime: jjjj-mm-dd hh:mm:ss 

'Date and time 24 hours before 

StartTime = DateAdd("h", -24, StartTime) 

'Split in years, months, days, hours, minutes, seconds 

SqlSec = Second(StartTime) 

SqlMin = Minute(StartTime) 

SqlHour = Hour(StartTime) 

SqlDay = Day(StartTime) 

SqlMonth = Month(StartTime) 

'Creating leading zeroes 

SqlSec = Right("00" & sqlSec,2) 

SqlMin = Right("00" & sqlMin,2) 

SqlHour = Right("00" & sqlHour,2) 

SqlDay = Right("00" & sqlDay,2) 

SqlMonth = Right("00" & sqlMonth,2) 

SqlYear = Right("00" & sqlYear,2) 

'Create string 

StartTime = "'" & SqlYear & "-" & SqlMonth & "-" & SqlDay & " 

" & SqlHour & ":" & SqlMin & ":" & SqlSec & "'" 

5.  The complete query is displayed in the variable "CommandText" for further 
processing. 

In this example, all messages stored in the message archive with message number 
< 4 are read out. If the runtime language is set to German 
(HMIRuntime.Language=1031), ALGVIEWEXDEU is entered for the "ViewName" 
parameter. If the English runtime language HMIRuntime.Language=1033) is active, 
"ALGVIEWEXENU" is selected. 

'Building the complete string 

Language = HMIRuntime.Language 

Select Case Language 

Case 1031  'German = 1031  

CommandText="ALARMVIEWEX:Select*FROM ALGVIEWEXDEU WHERE 

DateTime >" & StartTime& "MsgNr< 4 AND STATE = 1" 

Case 1033  'English = 1033 

CommandText="ALARMVIEWEX:Select*FROM ALGVIEWEXENU WHERE 

DateTime >" & StartTime& "MsgNr< 4 AND STATE = 1" 

End Select 
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No. Action 

6.  The command object is then created and the query is executed with the previously 
created "CommandText". 

The RecordSet is set to the command object and then set to the first record in which 
the first recorded and therefore oldest message is stored.  

'Create the recordset, read the records and set the first 

recordset: 

Set Command = CreateObject("ADODB.Command") 

Command.CommandType = 1 

Set Command.ActiveConnection = Conn 

Command.CommandText = CommandText 

Set RecSet = Command.Execute 

RecSet.MoveFirst 

 

Note When working with time and date in WinCC and Visual Basic, please note that 
the date format depends on the current region settings in Windows. The DDPS 
code should be designed so that the date and time can be evaluated 
independently of these computer-specific settings. 
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Writing the "*.csv" file 

The records will then be written from the previously opened RecordSet to the 
"*.csv" file. 

 

Table 2-13 

No. Action 

1.  A progress bar indicates writing of the data records. In the example, the following 
Recordset fields are read from the data record and written to the "*.csv" file.  

• DateTime (Time stamp) 

• MsgNr (Message number) 

• Text1 (Event text1)   

• Classname (Message class)  

• Type name (Message type)  

A line with the column headings is created once before, the currently set runtime 
language is also taken into account here.  

The RecordSet is placed on the next record with each run. 

'write recordsets To *.csv-File  

'Header in CSV-File 

Language = HMIRuntime.Language  

Select Case Language 

Case 1031  'German = 1031  

ts.WriteLine 

("Datum/Zeit;Meldenr.;Ereignis;Meldeklasse;Meldetyp")  

Case 1033  'English = 1033 

ts.WriteLine ("Date/Time;MsgNr.;Event;Messages Class;Messages 

Typ") 

End Select 

 

'writing recordsets 

Do While Not RecSet.EOF  

ts.WriteLine(RecSet.Fields("DateTime").Value & ";" & 

RecSet.Fields("MsgNr").Value & ";" & 

RecSet.Fields("Text1").Value & ";" & 

RecSet.Fields("Classname").Value & ";" & 

RecSet.Fields("Typename").Value)  

RecSet.MoveNext  

Loop 

2.  At the end of the script, the connection to the database is terminated and the 
objects are released. 

' Close all 

ts.Close  

RecSet.Close  

Set RecSet=Nothing  

Set Command = Nothing  

conn.Close    'Close connection  

Set Conn = Nothing  

Set fso = Nothing  

Set f = Nothing  

Set ts = Nothing 
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No. Action 

3.  Save the script. 

4.  The script is then available for the call. The script does not require any parameters. 

Calling the Function in the Process Screen 

The created procedure "WriteArchiveMessagesToCSV" does not require any 
transfer parameters for the call. In the image "ReverseOsmosis.Pdl" the script is 
called up via the corresponding button. 

Table 2-14 

No. Action 

1.  Open the image "ReverseOsmosis.Pdl" in the Graphics Designer. 

2.  Open the properties dialog of the "Export messages" button and open the DDPS 
editor under "Events > Mouse > Mouse Click > DDPS Action". 

 

3.  Create the following code to call the previously created VBS script: 

Sub OnClick(ByVal Item) 

WriteArchiveMessagesToCSV 

End Sub 

4.  Save the image. 

 

Note Alternatively, the function "WriteArchiveMessageToCSV" can also be called 
automatically. To do this, create a time-triggered or variable-triggered action in 
the DDPS editor. 
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2.3 Operation 

2.3.1 VBS cript for exporting archived variables 

Table 2-15 

No. Action Note 

1.  Start the runtime. 

 

2.  Click the button ("Reverse Osmosis") to open the image 
"Reverse Osmosis.Pdl".  

3.  Start the reverse osmosis system here via the button 
("START") in the control panel on the left-hand side.  

4.  Wait until the plant has reached the status "Production". 
 

5.  After a short run time, shut down the system with the "DEPTH" 
button.  

6.  After the system has reached the "Off" status and the stop 
time has been entered automatically under "Stop", press the 
"Export Variable" button. 

 

7.  Then open the "*.csv" file created on the drive under 
"C:\Temp\". 

 

 

2.3.2 VBS Script for exporting archived messages 

No. Action Note 

1.  Start the runtime.  

 

2.  Click the button ("Reverse Osmosis") to open the image 
"Reverse Osmosis.Pdl".  

3.  Start the osmosis system here via the button ("START") in the 
control panel on the left-hand side.  

4.  Wait until the plant has reached the status "Production". 
 

5.  After a short run time, shut down the system with the "DEPTH" 
button.  

6.  After the system has reached the "Off" status and the stop 
time has been entered automatically under "Stop", press the 
"Export Variable" button.  

7.  Then open the "*.csv" file created on the drive under 
"C:\Temp\". 
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3 Archive data exporting with Excel 

3.1 Principle of operation 

The Excel applications in this application example provide the user with simple 
tools with which he can access the process values and message data archived by 
WinCC. 

• Data access to the runtime archive is done with VBA scripts in Excel. 

• The archive data is transferred to Excel via the OLE DB Provider. 
 

Figure 3-1 

Project Data Runtime Data

*.XLS

WinCC/Connectivity Pack
OLE DB Provider

Excel Client

Archive

 

In this application example we provide you with two Excel clients for download: 

• The “Osmosis” client 

• The “Universal” client 
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The “Osmosis” client 

• The Excel client "38132261_Application_Reverse_Osmosis.xls" has a similar 
appearance to the associated WinCC project. 

• The time interval for the query (process values and messages) is freely 
adjustable. 

• The simultaneous readout of all relevant process values of the osmosis plant 
and their clear representation is possible. 

• The included scripts are optimized for easy traceability. Plausibility checks and 
UTC time adjustments were therefore deliberately omitted in order to maintain 
clarity. 

• Before using the client, the name of the server and the name of the WinCC RT 
database must be adapted in the respective script call. 

 

The “Universal” client 

• The Excel client "38132261_Application_Universal_Client.xls" can be used 
independently of the respective WinCC project. 

• It is possible to read the data from the WinCC runtime database of an OS 
server as well as a SIMATIC Process Historian. 

• Individual compilation of process value and message information is possible. 

• The free choice of interpolation of missing values (process values) is 
supported. 

• The time interval for the query (process values and messages) is freely 
adjustable. 

• The conversion between UTC (WinCC runtime database) and local time (Excel 
client) is performed automatically. 

• Access to the archives of different languages (messages) is supported. 

• Use of filters such as time span and message type (Messages) is supported. 

• An interpretation of the placeholders in the message texts (messages) is 
possible. 

• There is no need to modify scripts in the Excel client, the Excel client can be 
used for any WinCC project. 

• Plausibility queries regarding incorrect entries (e.g. time format) in the Excel 
client are carried out automatically. 
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3.2 The “Osmosis” client 

3.2.1 Principle of operation details 

This chapter contains information that will make it easier for you to extend the 
Excel application or adapt it to your individual needs. 

 

Note This chapter is only relevant for you if you are interested in the programmatic 
implementation or if you want to make changes to the Excel client. 

Basic knowledge of VBA programming is required. 

SQL command 

This section will help you to understand the function of the SQL command for 
reading the data. If you have basic knowledge of VBA programming and SQL 
database language, you will be able to extend the application in various ways after 
reading this manual. 

 

Note The SQL command used here contains a modification that is specifically required 
for communication with the WinCC OLE DB Provider. This causes the command 
to deviate partially from the specified standard. 
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Reading the variable archive 

The call by the button "ReadValues": 

'Execute writing archive values to excel sheet 

MeasuringPoint = "FI100_FlowRawwater" 

ExcelSheetName = "FI100" 

ErrorNumber = WriteArchiveValue(MeasuringPoint, ExcelSheetName) 

If ErrorNumber > 0 Then GoTo ErrorHandler 

 

Table 3-1 

Step Explanation 

1.  MeasuringPoint = "FI100_FlowRawwater" 

Enter here the name of the WinCC variable whose values are to be read from WinCC 
Runtime; here: FI100_FlowRawwater. 

2.  ExcelSheetName = "FI100" 

Enter the name of the Excel worksheet in which the read values are to be written; here: 
FI100. 

3.  ErrorNumber = WriteArchiveValue(MeasuringPoint, ExcelSheetName) 

The function "WriteArchiveValue" is called with the previously defined parameters. 

The variable "ErrorNumber" serves as the return value. 

4.  If ErrorNumber > 0 Then GoTo ErrorHandler 

If the return value is greater than 0, further processing is aborted and error handling is called. 

 
  

1 

2 

3 

4 
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The function "WriteArchiveValue" (in extracts): 

'Preparing the Connection-String 

Pro = "Provider=WinCCOLEDBProvider.1;" 'First instance of WinCCOLEDB 

DSN = "Catalog=" & cDSNRT & ";" 'Name of Runtime-Database 

DS = "Data Source=" & cMachineNameRT & "\WinCC" 'Data Source 

 

'Building the complete connection string 

ConnString = Pro + DSN + DS 

 

'Make Connection 

Set Conn = CreateObject("ADODB.Connection") 

Conn.ConnectionString = ConnString 

Conn.CursorLocation = 3 

Conn.Open 

 

'Building the complete command string: 

CommandText = "TAG:R,'" & cArchiveName & "\" & MeasuringPoint & 

"','" & StartArchive & ".000','" & StopArchive & ".000','TIMESTEP=" 

& TimeStep & ",5'" 

 

'Create the recordset, read the records and set to first redcordset 

Set Command = CreateObject("ADODB.Command") 

Command.CommandType = 1 

Set Command.ActiveConnection = Conn 

Command.CommandText = CommandText 

Set RecSet = Command.Execute 

RecSet.MoveFirst 

 

'Write recordset To Excel-Sheet 

With Worksheets(ExcelSheetName) 

.Range(.Rows(FirstLine), .Rows(.Rows.Count)).ClearContents 

End With 

ActualRow = FirstLine 

 

Do While Not RecSet.EOF 

    'Sequence: MeasuringPoint | ValueID | TimeStamp | RealValue 

    With Worksheets(ExcelSheetName) 

        .Cells(ActualRow, 1).Value = MeasuringPoint 

        .Cells(ActualRow, 2).Value = RecSet.Fields("ValueID").Value 

        .Cells(ActualRow, 3).Value = 

RecSet.Fields("TimeStamp").Value 

        .Cells(ActualRow, 4).Value = 

RecSet.Fields("RealValue").Value 

    End With 

 

    RecSet.MoveNext 

    ActualRow = ActualRow + 1 

Loop 

2 

3 

4 

5 

6 

1 
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Table 3-2 

Step Explanation 

1.  Pro = "Provider=WinCCOLEDBProvider.1;" 

An instance of the WinCC OLE DB provider is assigned to the provider variable; 
here: Provider=WinCCOLEDBProvider.1; 

DSN = "Catalog=" & cDSNRT & ";" 

The data source name is assigned to the data source name variable; 
here: Catalog=CC_WinCC73__17_09_14_13_34_26R; 

DS = "Data Source=" & cMachineNameRT & "\WinCC" 

The MS SQL Server instance is assigned to the Data Source variable as the data source; 
here: Data Source=HMI-1\WinCC 

2.  ConnString = Pro + DSN + DS 

The connection string variables are assigned the defined single variables as a whole string; 
here: 
Provider=WinCCOLEDBProvider.1;Catalog=CC_WinCC73__17_09_14_13_34_26R;Data 
Source=HMI-1\WinCC 

3.  Set Conn = CreateObject("ADODB.Connection") 

Conn.ConnectionString = ConnString : Conn.CursorLocation = 3 : Conn.Open 

The abstraction layer of ADODB opens a connection to the SQL database of WinCC. 

4.  CommandText = "TAG:R,'" & cArchiveName & "\" & MeasuringPoint & "','" & 
StartArchive & ".000','" & StopArchive & ".000','TIMESTEP=" & TimeStep & ",5'" 

Definition of the variables to be read, with the following specifications: 

• Archive name: 

• Archive tag 

• Start time ("StartArchive") of the period to be read out in the archive in UTC format 

• End time ("StopArchive") of the period to be read out in the archive in UTC format 

• Specifies the time period ("TimeStep") between two variable values and the aggregation 
type for summarization. 

Note: 

For more information on summarization ("TimeStep") and the aggregation type ("5"), see 
"Optional Adjustments for Reading the Variable Archive". 

5.  Set Command = CreateObject("ADODB.Command") 

Command.CommandType = 1 : Set Command.ActiveConnection = Conn 

Command.CommandText = CommandText : Set RecSet = Command.Execute 

RecSet.MoveFirst 

Via the abstraction layer of ADODB ("Command"), the values of the defined variables 
("CommandText") are read out via the open connection to the SQL database ("Conn") and 
assigned to a field ("RecSet"). 

6.  Do While Not RecSet.EOF 

    With Worksheets(ExcelSheetName) 

        .Cells(ActualRow, 1).Value = MeasuringPoint 

        .Cells(ActualRow, 2).Value = RecSet.Fields("ValueID").Value 

        .Cells(ActualRow, 3).Value = RecSet.Fields("TimeStamp").Value 

        .Cells(ActualRow, 4).Value = RecSet.Fields("RealValue").Value 

    End With 

    RecSet.MoveNext : ActualRow = ActualRow + 1 

Loop 

The entire field ("RecSet") is written line by line into the Excel worksheet ("ExcelSheetName") 
via a loop. Four columns are described for each row: 

• the variable name ("ExcelSheetName") 

• the variable ID ("ValueID") 

• der Time stamp ("TimeStamp") in UTC-Format 

• the variable value ("RealValue") 
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Reading the message archive 

The call by the button "ReadValues": 

'Execute writing archive values to excel sheet 

ExcelSheetName = "Alarms" 

Call WriteAlarms(ExcelSheetName) 

 

Table 3-3 

Step Explanation 

1.  ExcelSheetName = "Alarms" 

Enter the name of the Excel worksheet in which the read messages are to be written; here: 
Alarms. 

2.  Call WriteAlarms(ExcelSheetName) 

The subroutine "WriteAlarms" is called with the previously defined parameter. 

 

1 

2 
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The subroutine "WriteAlarms" (in extracts): 

'Preparing the Connection-String 

Pro = "Provider=WinCCOLEDBProvider.1;" 'First instance of WinCCOLEDB 

DSN = "Catalog=" & cDSNRT & ";" 'Name of Runtime-Database 

DS = "Data Source=" & cMachineNameRT & "\WinCC" 'Data Source 

 

'Building the complete connection string 

ConnString = Pro + DSN + DS 

 

'Make Connection 

Set Conn = CreateObject("ADODB.Connection") 

Conn.ConnectionString = ConnString 

Conn.CursorLocation = 3 

Conn.Open 

 

'Building the complete command string: 

CommandText = "ALARMVIEWEX:Select * FROM ALGVIEWEXENU WHERE DateTime 

>'" & StartArchive & "' AND DateTime <'" & StopArchive & "'" 

 

'Create the recordset, read the records and set the first recordset 

Set Command = CreateObject("ADODB.Command") 

Command.CommandType = 1 

Set Command.ActiveConnection = Conn 

Command.CommandText = CommandText 

Set RecSet = Command.Execute 

RecSet.MoveFirst 

 

'Write recordset To Excel-Sheet 

With Worksheets(ExcelSheetName) 

.Range(.Rows(FirstLine), .Rows(.Rows.Count)).ClearContents 

End With 

ActualRow = FirstLine 

 

Do While Not RecSet.EOF 

    'Sequence in Excel-Sheet: Date/Time | MsgNr. | Event |  Message 

Class | Message Typ 

    With Worksheets(ExcelSheetName) 

        .Cells(ActualRow, 1).Value = RecSet.Fields("DateTime").Value 

        .Cells(ActualRow, 2).Value = RecSet.Fields("MsgNr").Value 

        .Cells(ActualRow, 3).Value = RecSet.Fields("Text1").Value 

        .Cells(ActualRow, 4).Value = 

RecSet.Fields("Classname").Value 

        .Cells(ActualRow, 4).Value = RecSet.Fields("Typename").Value 

    End With 

 

    RecSet.MoveNext 

    ActualRow = ActualRow + 1 

Loop 

1 

6 

2 

3 
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Table 3-4 

Step Explanation 

1.  Pro = "Provider=WinCCOLEDBProvider.1;" 

An instance of the WinCC OLE DB provider is assigned to the provider variable; 
here: Provider=WinCCOLEDBProvider.1; 

DSN = "Catalog=" & cDSNRT & ";" 

The data source name is assigned to the data source name variable; 
here: Catalog=CC_WinCC73__17_09_14_13_34_26R; 

DS = "Data Source=" & cMachineNameRT & "\WinCC" 

The MS SQL Server instance is assigned to the Data Source variable as the data source; 
here: Data Source=HMI-1\WinCC 

2.  ConnString = Pro + DSN + DS 

The connection string variables are assigned the defined single variables as a whole string; 
here: 
Provider=WinCCOLEDBProvider.1;Catalog=CC_WinCC73__17_09_14_13_34_26R;Data 
Source=HMI-1\WinCC 

3.  Set Conn = CreateObject("ADODB.Connection") 

Conn.ConnectionString = ConnString : Conn.CursorLocation = 3 : Conn.Open 

The abstraction layer of ADODB opens a connection to the SQL database of WinCC. 

4.  CommandText = "ALARMVIEWEX:Select * FROM ALGVIEWEXENU WHERE DateTime 
>'" & StartArchive & "' AND DateTime <'" & StopArchive & "'" 

Definition of the messages to be read, with the following specifications: 

• Language of the messages to be read („ALGVIEWEXENU“) 

• Start time ("StartArchive") of the period to be read out in the archive in UTC format 

• End time ("StopArchive") of the period to be read out in the archive in UTC format 

Note: 

Further information on the language of the messages to be read out can be found under 
"Optional adjustments for reading out the message archive". 

5.  Set Command = CreateObject("ADODB.Command") 

Command.CommandType = 1 : Set Command.ActiveConnection = Conn 

Command.CommandText = CommandText : Set RecSet = Command.Execute 

RecSet.MoveFirst 

Via the abstraction layer of ADODB ("Command"), the values of the defined variables 
("CommandText") are read out via the open connection to the SQL database ("Conn") and 
assigned to a field ("RecSet"). 

6.  Do While Not RecSet.EOF 

    With Worksheets(ExcelSheetName) 

        .Cells(ActualRow, 1).Value = RecSet.Fields("DateTime").Value 

        .Cells(ActualRow, 2).Value = RecSet.Fields("MsgNr").Value 

        .Cells(ActualRow, 3).Value = RecSet.Fields("Text1").Value 

        .Cells(ActualRow, 4).Value = RecSet.Fields("Classname").Value 

        .Cells(ActualRow, 4).Value = RecSet.Fields("Typename").Value 

    End With 

    RecSet.MoveNext : ActualRow = ActualRow + 1 

Loop 

The entire field ("RecSet") is written line by line into the Excel worksheet ("ExcelSheetName") 
via a loop. Four columns are described for each row: 

• the Time stamp ("TimeStamp") in UTC format 

• MsgNr (Message number) 

• the message text 

• classname (Message class) 

• type name (Message type) 
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3.2.2 Configuration and project planning 

Storage Location 

The application does not have to be installed separately. Copy the file 
"38132261_Application_Reverse_Osmosis.xls" directly to the desired location. This 
Excel file contains the entire source code in the form of macros, which are 
executed in the background. 

Application call up 

Start the application by double-clicking on the Excel file. 

As soon as the application has opened, the following warning may appear, 
depending on your Excel settings: 

 

Figure 3-2 

 

 

The reason for this is that your macro security in Excel is set to "High". Change this 
setting accordingly. 

Overview 

The Figure 3-3 shows the application directly after its first call. Which interface is 
displayed depends on which register was active during the last save operation. The 
entries are also those that were made when you last saved. 

 

Figure 3-3 
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Required adjustments for reading the archives 

Computer-specific adjustments in the declaration area of the Excel client are 
required to read out the archives: 

1. Open the script editor of Excel with the key combination <ALT> + <F11>. 

2. Click on the "Constants" module (1) in the navigation area. 

Figure 3-4 

 

3. Change the name of the PC (2) on which the WinCC Runtime is running; 
here: HMI-1. 

Note The name can also be read in WinCC Runtime via the system variable 
"@LocalMachineName". 

4. Change the Data Source Name of the WinCC Runtime Database (2); 
here: CC_WinCC73__17_09_14_13_34_26R. 

Note • Make sure that the data source name of the WinCC Runtime database ends with an 
"R". 

• The Data Source Name can also be read in WinCC Runtime via the system variable 
"@DatasourceNameRT". 

• Alternatively, you can also follow steps 2 to 4 in Table 4-1 to read the Data Source 
Name of the WinCC Runtime Database under "Databases". 

• Alternatively, you can also use the name "CC_ExternalBrowsing". 

5. Enter the name of the variable archive (2) of the WinCC Runtime; 
here: Process value archive 

 

  

1 

2 
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Optional adaptations for reading the variable archive 

You can make appropriate changes in the "WriteArchiveValue" script to compress 
the data volume of a queried period of a variable. 

Scroll down to the entry "Building the complete command string": 

Figure 3-5 

 

Two parameters in the format "TIMESTEP= TimeStep,5" are required for 
compression: 

• The first parameter "TimeStep" is specified as an interval in seconds via the 
user interface of the Excel client. 
Example: 
If the archive values are available in a recording interval of two seconds and 
the query interval (TimeStep) is specified as "4", then only every second value 
is read (4 seconds interval between the individual values). 

• The second parameter, here: "5", has been permanently stored in the script 
and must either be changed there or also transferred to the user interface. This 
parameter is also known as the aggregation type and is responsible for 
creating intermediate values. 
 
The following values are possible for aggregation type: 
 

Table 3-5 

Without 
interpolation 

With interpolation Meaning 

1 (FIRST) 257 (FIRST_INTERPOLATED) First value 

2 (LAST) 258 (LAST_INTERPOLATED) Last value 

3 (MIN) 259 (MIN_INTERPOLATED) Minimum value 

4 (MAX) 260 (MAX_INTERPOLATED) Maximum value 

5 (AVG) 261 (AVG_INTERPOLATED) Mean value 

6 (SUM) 262 (SUM_INTERPOLATED) Total 

7 (COUNT) 263 (COUNT_INTERPOLATED) Number of values 
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Optional adaptations for reading the message archive 

Depending on the desired language of the queried messages, you can make 
appropriate changes in the "WriteAlarms" script. 

Scroll down to the entry "Building the complete command string": 

Figure 3-6 

 

The following parameters are reserved for the ViewName: 

 

Table 3-6 

ViewName (European languages) Language of the message texts 

ALGVIEWEXDEU German message archive data 

ALGVIEWEXENU English message archive data 

ALGVIEWEXESP Spanish message archive data 

ALGVIEWEXFRA French message archive data 

ALGVIEWEXITA Italian message archive data 

 

Table 3-7 

ViewName (Asian languages) Language of the message texts 

ALGVIEWEXCHS Chinese (simplified) message archive data 

ALGVIEWEXCHT Chinese (traditional) message archive data 

ALGVIEWEXJPN Japanese message archive data 

ALGVIEWEXKOR Korean message archive data 

 

Note The languages that are installed in the WinCC base system or that are 
configured in the WinCC Text Library are supported. Information concerning the 
possible query-languages or the respective "ViewName" can be found in the 
SQL-Server in the linked alarm archives under "Views". It displays all languages 
with their identifiers, e.g. "ALGVIEWEXENU", which are supported in the 
respective archive. 
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3.2.3 Operation 

Basic Steps 

1. Set the WinCC project "38132261_Application_Reverse_Osmosis_PROJ.zip" to 
runtime as described in chapter 2.2.1 "Configurations in the sample project". 

2. Open the supplied Excel client "38132261_Application_Reverse_Osmosis.xls". 

3. Make the settings on the Excel client as described in chapter 3.2.2 
"Configuration and project engineering". 

Read tag values 

1. Select the "Plant" tab. 

2. Enter the start time of the archive query in the format "YYYY-MM-DD 
hh:mm:ss". The time is specified in UTC format. 
Note: 
No plausibility checks are performed. 

3. Enter the start time of the archive query in the format "YYYY-MM-DD 
hh:mm:ss". The time is specified in UTC format. 
Note: 
No plausibility checks are performed. 

4. Specify the query interval in seconds. 

5. Click on the "ReadValues" button. 

 

Figure 3-7 
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Read messages 

1. Select the "Alarms" tab. 

2. Enter the start time of the archive query in the format "YYYY-MM-DD 
hh:mm:ss". The time is specified in UTC format. 
Note: 
No plausibility checks are performed. 

3. Enter the start time of the archive query in the format "YYYY-MM-DD 
hh:mm:ss". The time is specified in UTC format. 
Note: 
No plausibility checks are performed. 

4. Click on the "ReadAlarms" button. 

 

Figure 3-8 
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3.2.4 Error handling 

Table 3-8 

Error Possible cause 

 

Access to variable archive and/or message 
archive 

• The Excel client tries to read the variable 
archive, but the WinCC project was not started 
(RT not active). 

• The Excel client attempts to read the variable 
archive, but there are no values for the period 
queried. 

• The Excel client attempts to read the message 
archive, but there are no values for the period 
queried. 

 

Follow-up message Access to variable archive 

• The Excel client tries to read the variable 
archive, but the WinCC project was not started 
(RT not active). 

• The Excel client attempts to read the variable 
archive, but there are no values for the period 
queried. 

 

Access to message archive 

• The Excel client tries to read the message 
archive, but the WinCC project was not started 
(RT not active). 

• The Excel client tries to read the message 
archive, but the PC name in the script call is 
wrong. 

• The Excel client tries to read the message 
archive, but the DataSourceName (DSN) in 
the script call is incorrect. 

 

Access to variable archive 

• The Excel client tries to read the variable 
archive, but the PC name in the script call is 
wrong. 

 

Follow-up message Access to variable archive 

• The Excel client tries to read the variable 
archive, but the PC name in the script call is 
wrong. 

• The Excel client tries to read the variable 
archive, but the DataSourceName (DSN) in 
the script call is incorrect. 

 

Access to variable archive 

• The Excel client tries to read the variable 
archive, but the DataSourceName (DSN) in 
the script call is incorrect. 
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3.3 The “Universal” client 

3.3.1 Principle of operation details 

In this chapter you will find information that will make it easier for you to extend the 
"Alarms" tab of the existing application or to adapt it to your individual needs. 

 

Note This chapter is only relevant to you if you are interested in the programmatic 
implementation or if you want to make changes to the application. 

Basic knowledge of VBA programming is required. 

 

SQL command 

This section will help you to understand the function of the SQL command for 
reading the data. If you have basic knowledge of VBA programming and SQL 
database language, you will be able to extend the application in various ways after 
reading this manual. 

 

Note The SQL command used here contains a modification that is specifically required 
for communication with the WinCC OLE DB Provider. This causes the command 
to deviate partially from the specified standard. 

 

Components of the SQL command 

The explanation of the components of the SQL command will be based on an 
example and illustrate how the SQL command is composed in full length. The main 
focus of the description will be to show the variable parameters. 
In the following points, we will go into more detail on how these variable 
parameters are determined. 

Example SQL 

The following example shows an SQL command that uses all filter options of the 
application. 

"ALARMVIEW: SELECT TOP 65000 * FROM AlgViewEnu WHERE DateTime > 

'2009-3-17 0:0:0' AND DateTime < '2009-3-17 23:59:59' AND (CLASS = 1 

OR CLASS = 10) AND (Text2 = 'WEIGHT' OR (Text2 = '@2%s@' AND PText2 

= 'WEIGHT') ) ORDER BY DateTime ASC" 
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Explanation of command elements: 

In order to better understand the function of the various elements of the command, 
they are now explained in detail. 

 

Table 3-9 

Command element Explanation Var1 Opt2 

ALARMVIEW: The relevant database is the one for the alarm view 
(provider-specific addition). 

(-) (-) 

SELECT * All data fields (columns) in the table or view to be 
determined are searched for. 

(-) - 

TOP 65000 The number of messages returned by the query is 65000. (-) (-) 

FROM AlgViewEnu The data records are in the view 
„AlgViewEnu“. 
This name in turn contains several pieces of information: 

• General: Prefix for AlarmLogging 

• View: It is a view (not a table). 

• Enu: These are the alarms of the English project 
planning. 

Note: 
Unlike a table, a view does not contain any data records. It 
simply compiles the desired information by referring to 
different tables. 

x - 

WHERE DateTime > 
'2009-3-17 0:0:0' 
AND DateTime < 
'2009-3-17 23:59:59' 

The messages searched for occurred in the specified 
period (UTC). 

Note: 
The conversion from local time to UTC and back is done 
automatically by the application. 

x (-) 

AND (CLASS = 1 
OR CLASS = 10) 

Messages of the type "Alarm" (coded as class 1 within the 
database) and "Operating message" (class 10) are 
searched for. 

x x 

AND (Text2 = 

'WEIGHT' …) 

Only those messages will be returned that were created in 
the plant area (internally stored directly under "Text2" or 
referenced from there to the accompanying value "PText2") 
with the configured name "WEIGHT". 

x x 

ORDER BY DateTime 
ASC 

The messages are sorted in ascending order according to 
their date of origin. 

(-) (-) 

 

  

                                                      
1 Does the command element change depending on the settings made? 
2 Can the command element be omitted, depending on the settings made? 
x – Yes 
- – No 
(-) – No (related to the application in unchanged form) 
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Add reporting languages 

In this application, you can choose between archived notifications in five different 
languages. However, since WinCC is used worldwide, it is conceivable that you 
may want to access messages in other languages. 

This section describes how the language selection is currently being implemented 
and how you can adapt it to your requirements if necessary. 

It cannot be guaranteed that the procedure described below will be successful in 
every case. This depends above all on whether the name and structure of the view 
belonging to the language match the structure of the languages already 
implemented. 

Overview 

To change the message language, the user proceeds as described under 
"Operation - Edit basic settings". The language is selected via the "Language" 
drop-down list, which the application queries when creating the SQL command. 

The following table gives an overview of the currently available languages, the 
corresponding entries in the drop-down list and the names of the respective views. 

 

Table 3-10 

Language Drop-down list entry Name of view 

German German AlgViewDeu 

English English AlgViewEnu 

French Français AlgViewFra 

Italian Italiano AlgViewIta 

Spanish Español AlgViewEsp 

Explanation 

As you can see from the above overview, the names of the views differ only in their 
last three letters, which are used to define the reporting language. 

Furthermore, it becomes clear that in almost all cases the first three letters of the 
drop-down list entries correspond to the last three letters of the view names. 
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Procedure 

The following code is used to create the SQL command in the required form 
(VBAProject > Microsoft Excel Objects > Sheet2 > cmdAlarmRead_Click): 

 

'Select all columns 

strSQL = "ALARMVIEW: SELECT * FROM AlgView" 

'Select the table according to the project language 

If Left(cmbAlarmLang.Text, 3) = "Eng" Then 

    strSQL = strSQL & "Enu" 

Else 

    strSQL = strSQL & Left(cmbAlarmLang.Text, 3) 

End If 

 

After assigning the constant part of the SQL command, the system checks whether 
the selected entry in the drop-down list begins with "Eng". If this is the case, "Enu" 
is appended to the command. Otherwise, the first three letters of the drop-down list 
entry are appended. 
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Add Language 

To add a reporting language to the existing selection, proceed as follows: 

 

Table 3-11 

 Step Description 

1.  Expanding the drop-
down list 

To expand the drop-down list, edit the initialization 
instructions in the VBAProject > Microsoft Excel Objects 
> ThisWorkBook > Workbook_Open module. 

Add another message language to the existing command 
lines in the form cmbAlarm Lang.AddItem "English". 

2.  Checking the 
identifiers 

Use your SQL Server Management Studio to determine 
the name of the view belonging to this language. 

3.  Case 1: No necessary 
changes 

If the first three letters of your drop-down list entry match 
the last three letters of the view name, no further 
changes are required. 

4.  Case 2: Extending the 
If Statement 

If the letters differ, add a suitable ElseIf element to the If 
statement in the above code excerpt.  

 

Adding message types 

In the present version, the application is able to filter the archived messages 
according to up to six different message types. 
In addition to these six most common species, there are seven more in WinCC. It is 
also possible to create your own reporting types. 
It may therefore be necessary to add these to the filter. 

As in the previous section, the current conversion is presented here first, in order to 
show a possible change afterwards. 

Overview 

The use of the filter for message types is described in detail under "Operation - Edit 
filter settings". The option boxes are used to select the individual types and add 
them to the SQL command when it is created. 
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Procedure 

The following code implements the required extension of the SQL command 
"VBAProject > Microsoft Excel Objects > Sheet2 >. 
cmdAlarmRead_Click“: 

'Apply filter 

If chkAlarmAlarms.Value = True Or _ 

   chkAlarmWarnings.Value = True Or _ 

   chkAlarmASPLCMessages.Value = True Or _ 

   chkAlarmOSPLCMessages.Value = True Or _ 

   chkAlarmOperatingMessages.Value = True Or _ 

   chkAlarmSystemMessages.Value = True Then 

         

    'Flag to signalize that a part of the filter has 

    already been entered 

    'Depending on the flag, further parts of the filter 

    will be added in a different format 

    Dim boolIsFirst As Boolean 

    boolIsFirst = True 

         

    'If EventCategories are filtered a prefix is 

    necessary 

    strSQL = strSQL & "AND (" 

         

    If chkAlarmAlarms.Value = True Then 

        strSQL = strSQL & "CLASS = 1" 

        boolIsFirst = False 

    End If 

    If chkAlarmWarnings.Value = True Then 

        If Not boolIsFirst Then 

            strSQL = strSQL & " OR CLASS = 2" 

        Else 

            strSQL = strSQL & "CLASS = 2" 

            boolIsFirst = False 

        End If 

    End If 

    (…) 

    If chkAlarmSystemMessages.Value = True Then 

        If Not boolIsFirst Then 

            strSQL = strSQL & " OR CLASS = 18" 

        Else 

            strSQL = strSQL & "CLASS = 18" 

            boolIsFirst = False 

        End If 

    End If 

     

    'If EventCategories are filtered a suffix is 

    necessary 

    strSQL = strSQL & ") " 

End If 



3 Archive data exporting with Excel 

 

Exporting Archived Data from WinCC with the OLE DB Provider 
Entry-ID: 38132261,    V4.0,    06/2019  62 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

The Fig. 3-9 describes the structure of the above code excerpt. The grey area is 
executed once in the application for each filterable message type, with the 
exception of alarms. In order to improve the clarity, however, this section is only 
included representative once. 

 

Fig. 3-9 
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Add Language 

To extend the filter elements by another message type, follow the instructions in 
the table below: 

 

Table 3-12 

 Step Description 

1.  Remove sheet 
protection 

Before you can insert the control required for the extension, 
you must remove Excel's sheet protection. 

This is version-dependent and described in the Excel help. 

2.  Add control 
element 

Add another one to the existing radio buttons and give it a 
representative name. 

 

Note: 
To avoid layout problems, decouple the position and size 
properties of the control from the cell properties: 

1. Open the menu item "Format > Control...". 

2. Switch to the "Properties" tab. 

3. Select „Dont move or size with cells“. 

4. Confirm the change. 

3.  Expanding the 
source code 

Extend the above code section by one element of the shape: 
 
If chkAlarmSystemMessages.Value = True Then 

    If Not boolIsFirst Then 

       strSQL = strSQL & " OR CLASS = 18" 

    Else 

       strSQL = strSQL & "CLASS = 18" 

       boolIsFirst = False 

    End If 

End If 

 

Change the name of the radio button and the number of the 
reporting type. 

Add the following to the parent query 
(If chkAlarmAlarms.Value = True Or …) 

a corresponding condition 
(… Or chkAlarmSystemMessages.Value = True …). 

 

Note: 
You will find an overview of the coding of the message types 
used in the current project using SQL Server Management 
Studio. 

1. Select your WinCC Server when starting the application. 

2. Navigate to the following table (example): 
„Databases > CC_OS_1__09_03_19_18_33_31 > Tables 
> dbo.MSMsgGroup“ 

3. Take the corresponding coding from the column 
"GROUPDAT" in this table. The relevant entries are from 
"TYPE" 3. 

4.  Set sheet 
protection 

Create sheet protection again. This is version-dependent and 
described in the Excel help. 
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Expandability in message structure 

This application offers the possibility to display all message information (columns) 
that are also available under WinCC. However, the archived messages also 
contain further information such as "AlarmTag", "AckType" and "Servername", 
which are not available for selection with the present settings. 

In order to facilitate understanding, the current implementation is first explained. On 
this basis, step-by-step instructions are given on how to adjust the message 
structure. 

Overview 

The operation for adjusting the notification structure is described in detail under 
"Operation - Adjust notification structure". The settings are made in a separate 
window. After confirming the changes, the workspace is automatically adapted to 
the application. 
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Procedure 

The message structure influences the application in various areas. For the 
extension it is only important to know how the necessary basic information is 
initialized. All further processes adapt to the respective settings (as long as they 
correspond to the program logic). 

Three arrays form the basis for the message structure: 

 

Table 3-13 

Array Contents 

strAlarmDataNames Contains the names that are displayed to the user for 
selection. The current entries correspond to the names that 
are also used when editing the WinCC message structure 
in the Graphics Designer. 

 

Note: 
These names are different from those used in the database. 
They serve to enable the user to understand them as 
intuitively as possible. 

intAlarmRecordSetID Contains the position of each message information within 
the record set. 

 

Note: 
After the SQL command messages have been requested, 
they are returned as a record set. 
The structure of a record set is always the same as long as 
neither the data source (view) nor the queried structure 
(SELECT *) changes. Due to this fact, every piece of 

information in this record set has a fixed position. 

dblAlarmColumnWidth Contains the column width that is assigned to reporting 
information by default. 

 

Note: 
When adjusting the reporting structure, the width of the 
assigned column is automatically adjusted for each 
selected reporting information. (see "Operation - Adapt 
message structure"). This is done to ensure that the 
messages are displayed as optimally as possible. 
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The declaration of the arrays is made with the help of a constant, so that a uniform 
structure can be ensured "VBA-Project > Modules > MngAlarmPositions": 

Public strAlarmDataNames(1 To MAX_ALARM_DATA_COLUMNS) As String 

This constant corresponds to the number of reporting information, which is 38 by 
default. 

The arrays are addressed, e.g. during their initialization, via further constants, each 
of which corresponds to a message information "VBA-Project > Modules > 
MngAlarmPositions > InitializeAlarmArrays": 

strAlarmDataNames(C_DATE_TIME) = "Date / Time" 

This will improve the readability of the source code and simplify the process of 
making changes. 

 

The constants for the message information contain consecutive numbers "VBA-
Project > Modules > Constants" for shared constants or "VBA-Project > Modules > 
ConstantsAlarm" for alarm specific constants according to their function as index of 
the arrays: 

Public Const C_DATE_TIME = 1 

Public Const C_MS = 2 

Public Const C_PRIORITY = 3 

The standard information is arranged according to its order in the WinCC Graphics 
Designer. 

Expand message structure 

To extend the message structure, you only need to adjust the constants and array 
initializations. Proceed as described in the table: 

 

Table 3-14 

 Step Description 

1.  Adjusting the 
maximum value 
constant 

Under "VBA-Project > Modules > ConstantsAlarm" type 
enter the new number of reporting information for the constant 
MAX_ALARM_DATA_COLUMNS. 

 

Note: 
The constant adapts the application to the changed 
conditions. A correct value for this constant is therefore 
essential. 

2.  Adding the index 
constants 

In the same module, add as many index constants as 
required to the existing index constants (for example, 
C_PRIORITY). 

 

Note: 
Make sure that you assign the new numbers consecutively 
and that you do not exceed the value defined in 
MAX_ALARM_DATA_COLUMNS. 

3.  Extending the 
Array initialization 

The module "VBA-Project > Modules > MngPositions > 
InitializeArrays" initializes the presented arrays. 

Add as many elements to each of the three arrays as you 
want to add reporting information and fill them with the 
corresponding data (see Table 3-13). 



3 Archive data exporting with Excel 

 

Exporting Archived Data from WinCC with the OLE DB Provider 
Entry-ID: 38132261,    V4.0,    06/2019  67 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

3.3.2 Configuration and project planning 

Storage Location 

The application does not have to be installed separately. Copy the file 
"38132261_Application_Universal_Client.xls" directly to the desired storage 
location. This Excel file contains the entire source code in the form of macros, 
which are executed in the background. 

Application call up 

Start the application by double-clicking on the Excel file. 

As soon as the application has opened, the following warning may appear, 
depending on your Excel settings: 

 

Figure 3-10 

 

 

The reason for this is that your macro security in Excel is set to "High". Change this 
setting accordingly. 

Application window setup 

Figure 3-11 and Figure 3-12 show the application directly after its call. Which 
interface is displayed depends on which register was active during the last save 
operation. The entries are also those that were made when you last saved. 

 

Figure 3-11 
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Figure 3-12 

 

 

Note The user interface is completely in English. 
The selection in the "Alarm Language" drop-down list in the "Alarms" tab refers 
to the language of the messages to be read out. 

 

 

Switching between "Tags" and "Alarms" is done by selecting the corresponding tab 
at the bottom of the Excel window. 

 

Figure 3-13  
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Structure of the work area 

The structure of the work area is represented by the register "Alarm" as 
representative for both registers. 

 

Figure 3-14 

 

 

Each of the three selected areas has its own function, as shown in the Table 3-15. 

 

Table 3-15 

Area Function 

Control bar They make all the necessary settings via the control bar. This 
includes the selection of the data source and the definition of 
the message or process value filter. 

You can find a more detailed description of this area under 
"Configuration and project engineering - Structure of the 
operating bar".. 

Column headers The column headings determine the structure of the displayed 
messages. 

Note: 

You can adjust both the sequence and the composition 
according to your requirements. The exact procedure is 
described under "Operation - Adjust message structure" . 

Messages 

(Tab „Tags“: 
Process values) 

This area contains the read messages or process values with 
the structure you selected. 

 

Note The fields of the "Toolbar" and "Column headings" areas are protected to avoid 
unwanted changes. It is recommended not to remove this protection in order not 
to impair the functionality of the application. 
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Design of the operating elements 

In the control bar, you make all the settings necessary to display the data you want 
in a format of your choice. The structure of the control bar can be divided into three 
areas (for example, see Figure 3-15 for the "Alarms displayed" tab): 

• The basic settings which, once set, in most cases remain the same for the 
entire session. 

• The filter, which makes it possible to describe the searched archive data more 
exactly and thus to improve the search result. 

• The action area from which the structural adjustment of the displayed 
messages (selection of message blocks) or process values (selection of 
statistical values) and the actual read operation can be started. 

 

Each of these areas in turn contains several control elements, which are described 
in more detail in the section 3.3.3 on operating the application. 

 

Figure 3-15 

 

 

The Table View 

The display of the received archive data is variable and allows you to define an 
optimal structure for you. For process values, for example, various statistical 
functions can be executed and their results displayed. 

The table view for displaying the messages is based on the chronicle list of the 
WinCC message system. The display of the different message blocks can be 
designed individually, similar to the original (see "Operation - Adapt message 
structure"). 
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3.3.3 Operation 

This section describes how process values and messages can be read from the 
archives. With the exception of the explanation of the filter, this will be done using 
the procedure for messages as an example, since the differences in the handling 
of process values are very small. 

Application call up 

Table 3-16 

No. Description 

1.  Start the application. 
 
Note: 
After the start of the application it is possible that this short time does not react. 
This is because the network is busy and the list of available computers is 
progressing slowly. 

 
If there are several subnets, only members of the own workgroup are determined. 
However, you can also access computers that are not displayed as long as there 
is a valid connection to them. 
All you have to do is enter the name of the target computer in the text field of the 
"Host" drop-down list. 

2.  If necessary, activate the macros. 

Edit basic settings 

In the basic settings, you make settings that in most cases remain the same for the 
entire session. This includes defining the source computer and the reporting 
language. 

 

Table 3-17 

 Description control element 

1.  Select the "Alarms" tab. 

 

2.  In the "Host" drop-down list, select the 
computer that serves as the information 
source. 
After the program start, the name of the 
calling computer is entered. 

 

Note: 
It is necessary that the WinCC runtime is 
started on the computer specified here, since 
the WinCC OLEDB provider communicates 
with their services. 

In addition, it should be noted that only the 
data locally available on this computer is 
read. If you are using a CAS (Central Archive 
Server), you must choose between this (long-
term archive) and the OS server (short-term 
archive) in order to receive messages for a 
certain time period. 
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 Description control element 

3.  In the drop-down list, select the language in 
which the messages to be exported were 
configured. 

The following languages are available: 

• German 

• English 

• French  

• Italian 

• Spanish 

 
Note: 
The language selection is not available for 
process values. 

 
If one of these reporting languages is not 
planned separately, the messages in this 
language contain standard texts. 

 

Edit filter settings 

You can use the filter settings to reduce the archive data returned to those that 
really interest you with regard to day, time period and time interval (process values) 
or time, type and origin (messages). Differences between the procedure for 
process values and messages are explained in parallel steps. 

 

Table 3-18 

 Description control element 

1.  In the two input fields, specify the time period 
in which the archive data you are searching 
for was created.  
Make sure that the start time is before the 
end time. 
By default, the current date is set from 0 - 24 
o'clock. 

 

Note: 
The time and date must be entered in a fixed 
form: 
YYYY-MM-DD hh:mm:ss 
In addition, it must be ensured that the input 
is logical in itself (e.g. no 30 February, no 70 
minutes, etc.). If the value is invalid when 
leaving the input field, a warning will appear 
and the previously entered value will be 
restored. 
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 Description control element 

2.  For the tags tab: 

To read out the archived process values 
(tags) or the configured (plant) areas, click 
the button „Read Tags“ / „Areas“. 

 

Note: 
In order to perform the readout, the 
corresponding host must have been selected 
beforehand. 

Error handling: 
If you receive the following message, 
communication with the database has failed: 
"Area" / "Tag determination failed" + error 
description. 
Possible causes are: 

• Network problems (host not reachable) 

• Missing rights (same user and same 
passwords required) 

• OS not in runtime 

 
 

As soon as you have read the information, 
the corresponding drop-down list makes it 
available to you. 

 

3.  For the tags tab: 

In the "Archive Tags" drop-down list, select 
the process value whose archived values you 
want to read out. 

 

4.  For the tags tab: 

Enter the desired time interval in seconds 
over which the originally occurred values 
("native") are to be summarized. If no interval 
is to be used (values remain "native"), enter 
"0". 

 

Note: 
The time interval can be used to reduce the 
number of process values read without losing 
much information. 
The time interval allows you to combine all 
process values that have occurred in a 
particular time grid (e.g. all values in a minute 
or hour). Evaluations can then be made for 
this set of values (for example, maximum 
value, minimum value, total). This principle is 
illustrated in the Figure 3-16. 

 

For the "Alarms" tab: 
To filter messages according to different 
types (classes), you have a total of six option 
boxes at your disposal, which you can 
combine as you wish. If you do not make a 
selection here, filtering by messages is 
deactivated. 
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 Description control element 

5.  For the tags tab: 

Select whether an interpolation is to take 
place. 

 

Note: 
Interpolation requires a time interval other 
than zero. 

 
Interpolation ensures that the time interval 
between two received values always remains 
the same. If no value has been archived for a 
point in time, a corresponding intermediate 
value is determined from the directly 
preceding and the directly following archived 
value. 
Interpolation only takes place between two 
archived values within the time period. There 
is no interpolation between a value within and 
a value outside the time domain. 

 

 

Note You should use the filter options to limit the selection criteria as far as possible. 
This reduces the amount of relevant archive data and thus the access time to the 
database and the subsequent processing time. 

For messages, the number of data records returned is additionally limited to 
65000 by the SQL string. 

 

Explanation of the time interval 

The following figure shows the course of a process value over several hours. With 
the help of the vertical dashed lines, the curve is divided into the individual hours. 

 

Figure 3-16 

 

 

Assuming that the process values were archived every second, the listing of up to 
18000 values (for 5 hours) would be quite confusing. If, however, you specify a 
time interval of one hour, only a maximum of five values per column are specified. 
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In order to still get a good idea of the actual curve, it is possible to obtain various 
information about the number of values affected. This is illustrated in the detail view 
of the illustration. It is possible to determine the extreme values of the curve, the 
first and last values, the average and (not shown) the sum of all the values 
occurring in this interval and their number. 

If an interval according to these criteria shows a particularly conspicuous 
behaviour, you can then limit the time range accordingly and reduce the time 
interval so that all information is available to investigate the cause exactly. 

 

Adapt message structure 

Adjusting the message structure (selection of message blocks) allows you to 
display the received messages individually in a way that is optimal for you. 

If the message structure already corresponds to your wishes, you can skip this 
point. 

 

Figure 3-17 
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The following table describes how you can adapt the notification structure to your 
individual requirements. 

 

Table 3-19 

 Description control element 

1.  Click the button „Adapt Structure“. 

The Data Selection dialog box opens.  

2.  In the "Available Data" list on the left, select 
the element you want to add to the selection 
and click the button „->“. 

New elements of the right list "Selected Data" 
are always inserted after the currently 
selected element in this list. 

 

3.  To remove an element from the selection, 
select it from the list on the right and click on 
the button „<-“. 

Removed elements are added at the bottom 
of the left list. 

 

4.  Confirm your settings by clicking "OK". 

To discard the changes, click on the button 
„Exit“. 

 

Note: 

The adjustment of the data structure leads to 
the deletion of all currently listed messages. 
There is no additional query after confirmation 
of the changes. 

 

5.  After you confirm the changes, all column 
headings and messages are deleted. The 
new column headings are then entered and 
the column widths adjusted. 

 

Note: 
If you have not selected any columns for 
display, the subsequent read operation is 
aborted prematurely. The text "No Data to be 
read" is displayed in the status line. 
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Note When the application is started, it automatically determines the last used settings 
for the message structure from the entries in the "Column headings" subarea of 
the workspace. 

When selecting the information for process values, make sure that each piece of 
information other than the time stamp and the quality code triggers its own read 
operation. The reason for this is the functionality of the associated SQL query. 

Read messages 

After you have made all the settings, you can now read the required messages 
from the archive. 

 

Table 3-20 

 Description control element 

1.  Click the "Read" button to read the messages 
corresponding to the filter from the archive. 

 

Caution: 
Pressing the "Read" button deletes all 
currently listed messages. There is no 
additional query. 

Note: 
You can end the listing of messages 
prematurely by pressing the ESC key. 

 

2.  If necessary, save the read data separately.  

 

Note After triggering the read command, the SQL query is first created and executed. 
During this time, the application is not reactive because it has to wait for a 
response from the SQL server. Depending on the number of requested 
messages, this can take up to a few minutes. 

The formatting (replacement of the placeholders) and listing of the individual 
messages is then carried out. During this process, updating the workspace is 
disabled to increase message throughput and the status bar displays the 
progress of the process. 
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3.3.4 Error handling 

All error categories that can be assigned to the read operation are listed below: 

• Connection error 

– Process: 
Connect with the database 

– Message: 
"Error during Connect" + error description 

– Possible causes: 
Network problems (host not reachable); missing rights; missing installation 
of the WinCC OLE DB provider on the client 

 

• Read error 

– Process: 
Opening the database and reading the messages 

– Message: 
"Error during Open" + error description 

– Possible cause: 
WinCC is not in runtime on the server. 

 

• Processing error 

– Process: 
Arranging and interpreting the message blocks; entering the messages 

– Message: 
"Error during Processing" + error description 

– Possible cause: 
The structure of the database and therefore of the messages returned has 
changed. 

 



4 Export archive data with SQL Server 

 

Exporting Archived Data from WinCC with the OLE DB Provider 
Entry-ID: 38132261,    V4.0,    06/2019  79 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4 Export archive data with SQL Server 

4.1 Configuration 

• The export of archive values from SQL is parameterized directly in the "SQL 
Server Management Studio" with the help of the "SQL Server Import/Export 
Wizard". It is triggered after completion of the parameterization from the 
wizard. 

• It is also possible to save the created parameterization as an SSIS package 
(.DTSX file) in the Windows file system. The file allows the export at a later 
time. The SQL query and thus the scope of the data to be exported is stored in 
the SSIS package. 

• When accessing WinCC archive data, the source must be the WinCC OLE DB 
provider, e.g. a newly created, separate SQL database or a "*.xls", "*.xlsx", 
"*.txt" or "*.csv" file can serve as the data target.  

• The following instructions describe the parameterization of the "SQL Server 
Import/Export Wizard" for exporting archived measured values to a "*.csv" file. 

• The following instructions apply to SQL Server 2008 R2. 

 

Table 4-1 

No. Action 

1.  • Start WinCC-Explorer. Open the WinCC project. Enable runtime.  

•  Click the "Reverse Osmosis" button to switch to the image 
„ReverseOsmosis.Pdl“. 

• Start the reverse osmosis system via the "START UP" button. Wait until the 
plant has reached the status "Production".  

• After a few minutes, you can shut down the system by clicking on the 
"DEPARTURE" button.  

• Create an empty file "TagsToCSV.csv" and "AlarmsToCSV.csv" in the directory 
of your choice. 

2.  Start the "SQL Server Management Studio" under "Start > Programs > Microsoft 
SQL Server". 
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No. Action 

3.  • Log in. 

• Select "Database Engine" as server type, "<Your Computer Name>\WINCC" as 
server name and "Windows Authentication" as Authentication (your current 
user is used). 

• Connect to the SQL Server via the "Connect" button. 

 
 

4.  • Right-click the runtime and archive data database. To do this, use either 

– „Databases > CC_WinCC73__16_02_15_16_22_51R“, or 

– „Databases > CC_ExternalBrowsing“. 

• Start the SQL Server Import and Export Wizard with "Tasks > Export Data". 
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No. Action 

5.  Click on the „Next“ button 

 
 

6.  Select "WinCC OLE DB-Provider for Archives" as data source and then click on the 
"Properties" button.  

 

7.  • Enter ".\WinCC" as the data source and the name of the WinCC runtime 
database as the catalog. 

• As the WinCC Runtime database, enter either 

– „CC_WinCC73__16_02_15_16_22_51R“, or 

– „CC_ExternalBrowsing“. 

• Then exit the masks with the "OK" and "Next" buttons.  
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No. Action 

8.  • Select "Flat File Destination" as data destination and the file "TagsToCSV.csv" 
(for variable export). 

• Activate the checkbox "Column names in first data row" to write the column 
headers to the first line of the "*.csv" file.  

• Exit the mask with the "Next" button. 

 
 

9.  • Activate the option "Write a query to specify the data to transfer" to specify the 
SQL query in the next mask.  

• Continue the wizard via the "Next" button. 
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No. Action 

10.  • Enter the desired SQL query here. The structure of the query corresponds to 
the description in chapter 2.2.3 or chapter 2.2.4. 

• In this example, the archive tag "QI900_ConductivityPearmeatIn" from the 
process value archive from the period of the last 30 minutes is queried: 
 
TAG:R,'Process value archive\QI900_ConductivityPermeatIn','0000-00-00 
00:30:00.000', '0000-00-00 00:00:00.000'"" 

 
Notice 
When entering the text string, pay attention to the American spelling for 
quotation marks (see picture).  

• Exit the mask via the "Next" button. 
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No. Action 

11.  Set the column delimiter "Column delimiter" to semicolon. 

 
 

12.  • You can check the result of the query via "Preview".  

• Close the dialog with the "OK" button. 

Preview variable QI900: 
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No. Action 

13.  Then activate the saving of the "SSIS package" in the Windows file system without 
protective function and exit the mask with "Next".  

 
 

Note 

No protective function is required for the example project. In productive operation, 
this should be set up, depending on the application.  

14.  Specify the file name and location for the SSIS package and click the Next button.  
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No. Action 

15.  The set parameters are summarized in the next screen. With the button "Finish" the 
export is started. 

 
 

16.  • The result of the export is finally logged.  

• With the button "Reports" you have the possibility to save the log as a text file.  

 
 

17.  Check the generated "*.csv" file. 
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Note The archive can also be accessed via the ValueID instead of the variable name. 
This is more powerful than the symbolic name (e.g. "TAG:R,4,'0000-00-00 
00:30:00.000', '0000-00-00 00:00:00.000'"). 

 

A query of several archive variables with one SQL statement is possible with a 
list of ValueIDs. This is placed in parentheses in the SQL query, the ValueIDs 
are separated by semicolons. 

(e.g. „TAG:R,(4,8,12),’0000-00-00 00:30:00.000’, ’0000-00-00 00:00:00.000’”). 

 

The ValueID of the archive tags can be found in the table "dbo.Archive". Open 
this "Tables>dbo.Archive" via the context menu "Select Top 1000 Rows". 

 

Note When entering the text string, pay attention to the American spelling for quotation 
marks and quotation marks. 

Calling the "DTSX Packages" 

To repeat the export, execute the "SSIS Packages" (DTSX file) by double-clicking 
and then confirm the "Execute" button. The result is displayed in a Progress 
window. 
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5 Useful information 

5.1 Basics 

5.1.1 SIMATIC WinCC/Connectivity Pack 

The SIMATIC WinCC/Connectivity Pack is an option for WinCC. It enables licensed 
access to online and archive data from WinCC. The following standardized 
interfaces are available for this purpose: 

• OPC UA (Unified Architecture) 

With OPC UA WinCC supports the platform-independent successor technology 
of OPC. 

• OPC HDA (Historical Data Access) 

Access to archived process values. 

• OPC A&E (Alarm & Events) 

Access to reporting events and archived messages. 

• OPC XML DA (Web-based data exchange, cross-platform) 

• Archive Connector 

With it, swapped out WinCC archive databases can be connected to or 
disconnected for the SQL server. In doing so, an overview of the individual 
database segments is generated. The Archive Connector can monitor folders 
and automatically connect copied in archives. 

• WinCC OLE DB Provider 

Provider for direct access to the process and message archives in the SQL 
server database on the WinCC RT machine and on a long-term archive server. 
The WinCC OLE DB Provider also provides access to the archives connected 
to Archive Connector. 

5.1.2 WinCC OLE DB Provider 

In this document and the associated sample project, the use and application of the 
WinCC OLE DB provider is described. In addition to access to process value and 
message archives, this provides additional analysis functions, e.g. to determine 
extremes of archive variables. 

Since WinCC V6.0 the WinCC archive databases are segmented and stored in 
binary, encrypted form. With the WinCC OLE DB Provider, you make this data 
available transparently and in a readable form. When accessing this data, you do 
not need to take any measures to decrypt it or take segmentation into account. 

A WinCC/Connectivity Pack client has direct access to the archive data via the 
provider. Whether the data is available in compressed or decompressed form is 
therefore irrelevant. 

5.1.3 Prerequisite for the connection to the WinCC database 

To be able to connect to a WinCC archive, one of the following conditions must be 
fulfilled. 

• Part of a WinCC Runtime Project 

• Connected via "Attach Database" in SQL Manager 

• Connected via the Archive Connector 
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5.1.4 Using string tags 

As of WinCC V7.4 SP1, string variables can also be written to the variable archive. 
However, the WinCC OLE DB Provider requires a special SQL expression to read 
the string variables: 

Instead of 

"TAG:R, 1, '0000-00-00 00:10:00.00', '0000-00-00 00:00:00.000'" 

the 

"TAG_EX:R, 1, '0000-00-00 00:10:00.00', '0000-00-00 00:00:00.000'" 

must be used 
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5.2 Alternative solutions 

Several options and add-ons are available for exchanging data between SIMATIC 
WinCC and applications (e.g. Office applications, MES and ERP systems). The 
basis for this is a WinCC application. 

A distinction must be made between access to online values (current values from 
the variable household) of SIMATIC WinCC and historical data (e.g. archived 
variables or messages). 

The following list gives an overview of the possibilities offered by SIMATIC WinCC 
with its associated options and add-ons. The table does not claim to be exhaustive. 

 

Table 5-1 

Product 
WinCC 

integrated
1 

Option Add-on2 For data exchange 

SIMATIC WinCC x - - Accessibility via: 

• OPC DA  

SIMATIC 
WinCC/Connectivity 
Pack 

- x - Accessibility via: 

• OPC UA  

The successor of OPC with 
all access possibilities, like 
DA, HDA and A&E 

• OPC XML DA  

Online values of the 
variables 

• OPC HDA   

Logged process values 

• OPC A&E  

Messages and alarms 

• WinCC OLE DB Provider 

Logged process 
values/messages 

SIMATIC 
WinCC/IndustrialData
Bridge 

- x - Configuration tool and 
runtime environment for 
data exchange between 
different data sources 
(providers) and data targets 
(consumers). Can also be 
used standalone.  

 

Note: 

From WinCC V7.4 "*.txt"-, 
"*.csv"-, "*.html"-, "*.xml"- 
formats permitted. 

SIMATIC Information 
Server 

- - x Allows you to save the 
report in various formats, 
including "*.xls" format. 

PM-OPEN EXPORT - - x Export of online values and 
archive data to text files 
("*.ascii", "*.csv", "*.html", 
".*xml"). 

                                                      
1 SIMATIC WinCC RT / RC – license sufficient 
2 Add-Ons are products from our Premium Add-On Partners 
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6 Appendix 

6.1 Service and support 

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, application examples and videos 
– all information is accessible with just a few mouse clicks: 
https://support.industry.siemens.com 
 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers  
– ranging from basic support to individual support contracts. Please send queries 
to Technical Support via Web form: 
www.siemens.com/industry/supportrequest 
 

SITRAIN – Training for Industry  

We support you with our globally available training courses for industry with 
practical experience, innovative learning methods and a concept that’s tailored to 
the customer’s specific needs. 

For more information on our offered trainings and courses, as well as their 
locations and dates, refer to our web page: 
www.siemens.com/sitrain 

 

Note Basics are taught in the SITRAIN course "SIMATIC WinCC, System Course." 

• SIMATIC WinCC, Systemkurs (de) 

• SIMATIC WinCC, System Course (en) 

Topics for cross-system communication with the WinCC/Connectivity Pack are 
taught in the course "SIMATIC WinCC, Advanced Course", among many other 
topics. 

• SIMATIC WinCC, advanced course (de) 

• SIMATIC WinCC, advanced course (en) 

  

https://support.industry.siemens.com/
http://www.siemens.com/industry/supportrequest
http://www.siemens.com/sitrain
https://www.sitrain-learning.siemens.com/DE/de/product/chapter/QAJ857V/course/4102607/description.do?hash=70ed32afecd3c67038578705e4f37c1c
https://www.sitrain-learning.siemens.com/DE/en/product/chapter/QAJ857V/course/4102608/description.do?hash=edfd73c2d6d9671c5c03b013f7fde363
https://www.sitrain-learning.siemens.com/DE/de/product/chapter/QAJ857V/course/4102612/description.do?hash=9e224570ae6603baa50da8cbb5b1a9ab
https://www.sitrain-learning.siemens.com/DE/en/product/chapter/QAJ857V/course/4102613/description.do?hash=03ddf8bfcd25d620b76bfb1b7069ca5f
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Service offer 

Our range of services includes the following:  

• Plant data services 

• Spare parts services 

• Repair services 

• On-site and maintenance services 

• Retrofitting and modernization services 

• Service programs and contracts 

You can find detailed information on our range of services in the service catalog 
web page: 
https://support.industry.siemens.com/cs/sc 
 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for Apple iOS, Android and Windows 
Phone:  
https://support.industry.siemens.com/cs/ww/en/sc/2067 
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6.2 Links and literature 

Table 6-1 

No. Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link to the entry page of the application example  

https://support.industry.siemens.com/cs/ww/en/view/38132261 

\3\ Manual SIMATIC WinCC/Connectivity Pack V7.4 SP1 

https://support.industry.siemens.com/cs/ww/en/view/109746336 

\4\ Application example "Export of WinCC/CAS archive data with an independent 
application". 

https://support.industry.siemens.com/cs/ww/en/view/35840700 

\5\ Application example "WinCC/IndustrialDataBridge: Write data from SIMATIC 
WinCC or from SIMATIC controllers to Office files". 

https://support.industry.siemens.com/cs/ww/en/view/109483465 

 

6.3 Change documentation 

Table 6-2 

Version Date Change 

V1.0 08/2009  First edition, WinCC 7.0 + ConnPack 

V2.0 02/2016  WinCC 7.3 + ConnPack, new layout of the application 
example + revised scripts. Changes in the documentation. 

V3.0 03/2018  WinCC 7.4 SP1 + ConnPack, revised scripts + export of 
archive files to Excel. Changes in the documentation. 

V4.0 06/2019 WinCC 7.5 + ConnPack, additional Excel client with basic 
functionality based on the WinCC project. Changes in the 
documentation. 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/de/view/38132261
https://support.industry.siemens.com/cs/ww/en/view/109746336
https://support.industry.siemens.com/cs/ww/en/view/35840700
https://support.industry.siemens.com/cs/ww/en/view/109483465
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